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Chapfter

Introduction

How to Use This Manual

This manual provides the information necessary for installing Sage
ERP MAS 90, Sage ERP MAS 200, and Sage ERP MAS 200 SQL. This
manual also contains information and troubleshooting tips on the
configuration of the various operating systems and environments in
which the Sage ERP MAS software is supported. The instructions
contain detailed technical information on the configuration of
operating systems and environments.

The screens used in this manual are from Sage ERP MAS 200; similar
screens appear in Sage ERP MAS 90 and Sage ERP MAS 200 SQL.
Note that Business Insights Reporter and the eBusiness Manager,
Electronic Reporting, Fixed Assets, Job Cost, Material Requirements
Planning, Payroll, TimeCard, and Work Order modules are not
available for Sage ERP MAS 200 SQL.

For a complete listing of operating system requirements, see the

Supported Platform Matrix in the Support area of the Sage Online
Web site at: www.sagesoftwareonline.com
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Chapter 1 Introduction

Graphic Conventions

The following icons are used throughout this manual to indicate different
types of information.

The NoTE symbol is followed by additional
é information about a topic.

The WARNING symbol is followed by information

to help you avoid costly mistakes.

The INFORMATION symbol is used when a chapter

does not apply to all three Sage ERP MAS

products. The symbol is followed by the

product(s) to which the section does apply.
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HOW TO USE THIS MANUAL

Text Conventions

The following table describes the text conventions used in this manual.

Text Convention Explanation

Menus Menus are shown in this format:
Select menu > menu task name.

Examples:

¢ Select File menu > Change
Company.

¢ Select General Ledger Budget
menu > Budget Maintenance.

Bold font Indicates text entered at a field or text
selected at a field.

Examples:

e At the Value field, type a search
value, such as 01, for the lookup.

¢ In the Filter window, to delete a
filter, select <none> at a filter's
Column field.

Italic font Indicates references to other manuals.
Example:

¢ For more information, refer to your
Getting Started Guide.
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Chapter 1 Introduction

Installation Overview

Read this guide completely before installing or upgrading your Sage ERP
MAS system. Before installing your Sage product, your hardware must be
properly configured, and the appropriate operating system software must
be fully installed and operational. Incorrect configurations of protocols and
services running on the server can cause major delays in the implementation of
your Sage ERP MAS system.

The installation procedures in this document address Windows®
environments. For a complete listing of operating system requirements, see
the Supported Platform Matrix in the Support area of the Sage Online Web
site at: www.sagesoftwareonline.com

In this guide, you will notice references to MAS90 when dealing with
installation paths or system file names for Sage ERP MAS 200 and Sage ERP
MAS 200 SQL.

In some parts of this guide, the Sage ERP MAS Integration Engine is
referred to simply as the Integration Engine.

Contents of Product DVD

The Sage ERP MAS 90, 200, and 200 SQL product DVD contains the
following:

& NoTe * Installation programs for Sage ERP MAS 90, 200, and 200 SQL. To access
Theinstallatonpvp  these programs, select a product from the Autorun screen.

includes setup

programs for three Installation program for SageCRM 7.1 Server. To access this program,

Sage ERP MAS select a product from the Autorun screen.
products; however,
you will be able to
install only the

Documentation for Sage ERP MAS products, which includes a PDF

product for which version of this guide, as well as the Getting Started Guide and the

your product key is Customer Upgrade Guide. To access the documentation, select a product

valid. from the Autorun screen, and then click Documentation on the product
screen.
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INSTALLATION OVERVIEW

* Installation programs for eBusiness Web Services and the Sage Web
Engine. To access these programs, select a product from the Autorun
screen, and then select Productivity Applications. To access the
installation guides for these products, select Documentation from the
product screen.

* Documentation for SageCRM, which includes the Installation and
Upgrade Guide and the System Administrator Guide. To access the
SageCRM documentation, use Windows Explorer to locate the
CRM\Documentation folder on the Sage ERP MAS product DVD.

e Productivity applications, such as Crystal Reports® Designer and
Acrobat Reader. To access these programs, select a product from the
Autorun screen, and on the product screen, select Productivity
Applications.

General Installation Tips

Keep the following in mind when installing your Sage ERP MAS system:

* If your serial number includes leading zeros, be sure to include all zeros
when typing the number.

* When specifying where to install Sage ERP MAS, do not nest a
destination folder in folders named MAS90 or SOA.

¢ Installing Crystal Reports Designer is optional; however, it must be
installed on the workstation if you want to create new reports and
modify existing ones (see Installing Crystal Reports Designer on
page 77).

A WARNING

Do not integrate

You can install modules that have not been purchased and access most

N of them for 45 days before you are required to purchase and register
ﬁ:&uﬁggcwiﬁe them. The 45-day trial period begins the first time the module is
nonregistered accessed. The eBusiness Manager, Custom Office, Electronic Reporting,
modules unlessyou  and Visual Integrator modules must be registered before they can be
plan to purchase accessed. Modules that have been purchased are automatically selected
those modules. . .

for installation.
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Chapter 1 Introduction

¢ If you are upgrading, all modules installed on your source system must
be installed on the new installation. After you have upgraded to the
current version, you can delete modules that are no longer needed.

* If the Customer Relationship Management module is installed, the Sage
ERP MAS Integration Engine will also be installed.
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Chapter w4

Installing Sage ERP MAS 90

Read this guide completely before installing and setting up Sage ERP
MAS 90. A series of procedures must be completed for new
installations. When upgrading a system, there are additional
post-installation requirements for migrating existing data and
converting it to the current version.

Installation Requirements

The computer where you are installing Sage ERP MAS 90 should
have a minimum of 750 MB of free disk space, depending on the
number of applications to be installed. Verify that you have 600 MB of
disk space available for System Setup and Library Master, plus an
additional 15 to 25 MB for each module to be installed.

For information on the specific operating system requirements, see
the Supported Platform Matrix in the Support area of the Sage Online
Web site at: www.sagesoftwareonline.com

Pre-Installation Tasks
Perform these tasks before beginning the installation process.

e If you are upgrading from a prior version, read the Customer
Upgrade Guide, which is available on the Sage ERP MAS product
DVD.

* Verify that you have your packing list, which includes the serial
number, customer number, user key, and product key, which are
required to install Sage ERP MAS 90 for the correct number of
users and to register the modules. This information is also
available on the Sage Online Web page under Profile Mgmnt >
Products.
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! Chapter2 Installing Sage ERP MAS 90

¢ Test and validate all of the hardware and network configurations using
the following resources, which can be found in the Support area of the
Sage Online Web site at: www.sagesoftwareonline.com

* The Supported Platform Matrix
e The Integrated Solutions Compatibility Matrix
¢ The current support library

A WARNING ¢ If you are upgrading from Sag'e ERP MAS 90 Ve.rsion 4.49, determine
If you are upgrading whether to perform a parallel installation or an in-place installation.

from version 4.30 or
earlier,youmust o If you will be installing the Sage Web Engine, verify that IIS is installed

install Sage ERP and running.
MAS 90 version

4.50 to a new . . e e .
location and then If a prior version of the Sage Web Engine is installed for the eBusiness

perform a parallel Manager module, back up any customized templates in the IW folder to
migration tomigrate  another location, and then uninstall the Sage Web Engine. After the 4.50
your existing data. Sage Web Engine is installed, move the templates back to the IW folder.

¢ If you are installing the Payroll module, you must also install the Payroll
Tax Table. Failure to install the Payroll Tax Table will cause a FILE
PRU.SOA NOT FOUND message to appear when Payroll is first set up
for a company.

* Third-party applications used with Sage ERP MAS 90 may require a
drive mapping or UNC to the server where the data files are located.
This drive must be mapped to a share point on the server above the
MAS90 folder. Although Sage ERP MAS itself does not require a logical
drive mapping, any application written to access the data files
(including third-party or Sage developer partner applications) must
have a valid logon to the server and may require a logical drive mapping
or UNC.

¢ If you are installing on a Windows server, review Considerations for
Installing on a Windows Server on page 14.

¢ If you are installing on a peer-to-peer network, review Considerations
for Installing on a Windows Peer-to-Peer Network on page 15.

8 Installation and System Administrator's Guide



INSTALLATION PROCESS

¢ If you are installing SageCRM, create a Windows user account with
permissions to access both the server where Sage ERP MAS 90 will be
installed and the SQL Server database. This account is used by the
Integration Engine to send data between the Sage ERP MAS 90 server
and the SageCRM server. You are asked to provide this information
during the Sage ERP MAS 90 installation if the Customer Relationship
Management module is selected for installation. For more information,
see Installing SageCRM on page 43.

Installation Process

Run the Sage ERP MAS 90 installation wizard program to install a new
instance of Sage ERP MAS 90 or to upgrade your system from a prior
version. The installation wizard guides you through the installation.

To install Sage ERP MAS 90

1 Start Windows; if you are installing to a Windows server, run the Setup
program from the Windows server, not from a workstation connected to
the server.

2 Close down other programs. Do not close antivirus, antispyware, and
script-blocking software unless it is actually interfering with the
installation.

Vi 3 DPlace the Sage ERP MAS product DVD in the DVD drive.
NoTE

When specifying 4

; If Autorun is enabled on the server, the Autorun screen appears;
where to install

Sage ERP MAS, do otherwise, select Windows Start menu > Run and type D:\ Autorun.exe,
not nest a where D:\ is the DVD drive. The wizard must be launched from the
destination folder in Autorun screen, not from the individual setup files on the DVD.

folders named

MAS900rSOA- 5 On the Autorun screen, click Sage ERP MAS 90.
6 On the Sage ERP MAS 90 screen, click Install Sage ERP MAS 90.

7 Follow the steps in the installation wizard to install a new instance or
upgrade an existing installation.
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! Chapter2 Installing Sage ERP MAS 90

The time required for installing depends on the number of modules
& Note selected. If several modules are installed, this process may take several

If a message dialog minutes.
box appears asking

you to restart the . . . .
computer. you must If you receive a message stating that no installation of Adobe Acrobat

dosobeforethe  Reader was detected, click OK to continue with the installation. After the

installation willbe  installation is complete, the Sage ERP MAS 90 screen appears. Click

fully functional. Productivity Applications, and then click Install Acrobat Reader to install
the application. For more information, see Productivity Applications on
page 13.

Post-Installation Tasks
Perform the following tasks after installing Sage ERP MAS 90.
1 If you are upgrading, refer to your Customer Upgrade Guide.

2 Install any version 4.50 product updates available on the Sage Online
Web site at: www.sagesoftwareonline.com

3 If you plan to run Workstation Setup so that additional computers can
access the Sage ERP MAS 90 installation, create a share at least one
folder above the MAS90 folder. This is required before running
Workstation Setup. For more information, see Sage ERP MAS Security
Permissions on page 145.

4 To run Microsoft Script links, you must have the Microsoft Windows
Script Host processor on your system. For information on installing the
Microsoft Windows Script Host processor, refer to the Microsoft
Download Center Web site.

5 Install SageCRM if you plan to use that product (see Installing
SageCRM on page 43).

6 Run Workstation Setup on any workstations that will access the Sage
ERP MAS 90 installation (see Workstation Setup on page 11).

7 Install optional productivity applications, such as Crystal Reports

Designer, on each workstation as needed. Installing Crystal Reports
Designer is necessary only if you plan to create or modify reports.
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WORKSTATION SETUP

8 If you are installing Federal and State eFiling and Reporting, you must
install it on each Sage ERP MAS workstation. For more information, see
Installing Federal and State eFiling and Reporting on page 89.

9 Create companies and activate modules (see Creating and Activating
Companies on page 98).

10 Create roles and user codes, and set up system preferences (see Setting
Up Roles and Users for Security on page 104).

11 Set up the modules for your companies. If you are converting your
existing business management system to Sage ERP MAS 90, assemble
the data you need to set up each module. For more information, refer to
your Getting Started Guide.

Workstation Setup

& Noe The Workstation Setup wizard installs the required software and common
Run the programs to the workstations that will access the Sage ERP MAS 90
Workstation setup  installation. The workstation installation wizard copies all of the necessary
program after every Dynamic Link Libraries, ActiveX controls, and other components to the
Sage ERP MAS 90 ]ocal Windows\System folder and sets up the initialization files for the
software upgrade. v estation.

Workstation Setup Requirements

For workstation operating system requirements, see the Supported
Platform Matrix in the Support area of the Sage Online Web site. The
workstation hard drive should have a minimum of 750 MB of free disk
space. An additional 1 GB of disk space is required to install Crystal
Reports Designer; 1.5 GB is recommended. Installing Crystal Reports
Designer is necessary only for creating and modifying forms and reports.

If you have installed Sage ERP MAS 90 on only one computer, it is not
necessary to run Workstation Setup to access Sage ERP MAS 90 on that
computer; Workstation Setup is necessary only for additional workstations
that will be accessing the installation.

Installation and System Administrator's Guide 11



! Chapter2 Installing Sage ERP MAS 90

/A WarninG Running Workstation Setup

The Workstation . . . .
Setup wizard wil To facilitate ease of installation, the Workstation Setup program should be

run only if it is run from the server where Sage ERP MAS 90 is installed; however, running

executedfroma  the program from the product DVD may be faster for remote users.
mapped drive letter.

Do not run the .

Workstation Setup 10 run Workstation Setup

wizard from a UNC

path or through 1 Close down other programs. Do not close antivirus, antispyware, and
Network script-blocking software unless it is actually interfering with the
Neighborhood. . .

installation.

2 Map a drive letter to the share point above the MAS90 folder where the
Sage ERP MAS 90 server component is installed.

3 Perform one of the following to start the installation:

¢ To run the Workstation Setup wizard from the Sage ERP MAS 90
server installation folder (the preferred method):

a Use Windows Explorer to attach to the server share point where
Sage ERP MAS 90 is installed, and locate the MAS90\ Wksetup
folder.

b Double-click Wksetup.exe to run the program; it takes a few
seconds to launch.

¢ To run the Workstation Setup wizard from the Sage ERP MAS
product DVD:

a Place the Sage ERP MAS product DVD in the DVD drive. If
Autorun is enabled on the computer, the Sage ERP MAS Autorun
screen appears. If the Autorun screen does not appear, on the
Windows Start menu, select Run, and type D:\ Autorun.exe where
D:\ is the DVD drive.

é NOTE

If a message dialog b On the Autorun screen, click Sage ERP MAS 90.

box appears asking
you to restart the
computer, you must

¢ On the Sage ERP MAS 90 screen, click Install Sage ERP MAS 90

do so before the Workstation.
installation will be
fully functional. 4 TFollow the steps in the Workstation Setup wizard.
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PRODUCTIVITY APPLICATIONS

If you receive a message stating that no installation of Adobe Acrobat
Reader was detected, click OK to continue with the installation. After the
installation is complete, the Sage ERP MAS 90 screen appears. Click
Productivity Applications, and then click Install Acrobat Reader to install
the application. For more information, see Productivity Applications on this

page.

Productivity Applications

The following third-party applications are required to perform certain tasks
on the workstation. These applications can be installed from the
Productivity Applications screen on the Sage ERP MAS product DVD.

* Adobe Acrobat Reader is needed to view Paperless Office documents,
the online user guides, the module report samples, and module
overview PDFs in the Help system.

* Crystal Reports Designer must be installed on each workstation where
reports will be created or modified. For more information, see Installing
Crystal Reports Designer on page 77.

Third-Party Applications for SageCRM

The following third-party applications are required to perform certain
SageCRM tasks on the workstation.

* Mail Merge Plug-In is required to use the mail merge functionality. The
first time a user encounters one of the features requiring the plug-in (for
example, the My CRM menu > Calendar page displaying the Document
Drop icon), they are prompted to download the plug-in. Instructions are
provided on-screen. The user must be an administrator or power user of
the client machine to install the Mail Merge Plug-In. The client browser
must also be configured to accept plug-ins.

* Microsoft Office Applications are required for users who will be using
the mail merge and document merge features supported by SageCRM;
Microsoft Word and Excel should be installed on their workstations. The
data upload feature accepts files in XLS format, created by Microsoft
Excel.

Installation and System Administrator's Guide 13



! Chapter2 Installing Sage ERP MAS 90

* Microsoft Internet Explorer is required for users to access the SageCRM
software.

* Outlook Plug-In is required for SageCRM Outlook Integration. Users
can download the Outlook Plug-In from within SageCRM in the My
CRM menu > Preferences tab. The user must be an administrator or
power user of the client machine to install the Outlook Plug-In.

If installing SageCRM Outlook Integration in a Terminal Services
environment, administrator rights are required on the Terminal Services
computer. All instances of Internet Explorer and Outlook must be closed
to install the plug-in. At the time of the installation, exclusive access to
the server is required for each user. After the plug-in is installed,
administrator rights are no longer required.

Considerations for Installing on a Windows Server

The following are special considerations to be aware of before installing or
upgrading Sage ERP MAS 90 on a Windows network.

For the hardware and service pack requirements for both the workstations
and server, see the Supported Platform Matrix located in the Support area
of the Sage Online Web site at: www.sagesoftwareonline.com

* Perform the DVD installation on Sage ERP MAS 90 directly at the server.

e When installing, close down all other visible desktop applications (for
example, Microsoft Office applications). Do not shutdown antivirus and
antispyware software unless it is actually interfering with the
installation.

* At the server, create a share at a parent folder above the MAS90 folder.

Do not create the share directly at the MAS90 folder. Every workstation
will be required to map a drive to this share point.
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CONSIDERATIONS FOR INSTALLING ON A WINDOWS PEER-TO-PEER NETWORK

¢ Each workstation must recognize the network drive on which Sage ERP
MAS 90 is loaded using a mapped drive letter. Using Universal Naming
Convention (UNC) paths is not supported.

Example:

Correct
F:\Mas90\Home\Pvxwin32.exe

Incorrect
\\Servername\Sharename\Mas90\Home\Pvxwin32.exe

If company data is moved to a different data location using Library
Master Company Maintenance, the same drive letter must be used from
all workstations to point to the alternate folders, including the server if
it is used as a workstation.

Make sure the drive mapping is created so it remains persistent after
restarting the workstation. Generally this is accomplished either
through a logon script or by selecting the Reconnect at Logon check box
in the Map Network Drive window on the workstation.

Considerations for Installing on a Windows Peer-to-Peer
Network

Vi For the hardware and service pack requirements for both the workstations
NOTE and server, see the Supported Platform Matrix located in the Support area
Installing on a of the Sage Online Web site at: www.sagesoftwareonline.com

peer-to-peer 8 : -Sag :

network is

supported only for  ® The server and all workstations must be using the same operating
Windows XP system.

Professional.

* When running with more than two users, the workstation acting as the
server should be dedicated. Running Sage ERP MAS 90 on the server
concurrently while other users are accessing Sage ERP MAS 90 from
their own workstations may result in instability and performance issues.

* A maximum of five users is supported when running in the peer-to-peer
environment.
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* At the server, create a share at a parent folder above the MAS90 folder.
Do not create the share directly at the MAS90 folder. Every workstation
will be required to map a drive to this share point.

If Windows XP Professional has Simple File Sharing enabled, when
creating the share, select the Allow Network Users to Change My Files
check box. To verify if Simple File Sharing is enabled, select Windows
Start menu > My Computer. Then select Tools menu > Folder Options.
Click the View tab and scroll to the bottom. Verify that the Use Simple
File Sharing (Recommended) check box is selected.

Each workstation must recognize the network drive on which Sage ERP
MAS 90 is loaded using a mapped drive letter. Using Universal Naming
Convention (UNC) paths is not supported.

Example:

Correct
F:\Mas90\Home\Pvxwin32.exe

Incorrect
\\Servername\Sharename\Mas90\Home \Pvxwin32.exe

If company data is moved to a different data location using Library
Master Company Maintenance, the same drive letter must be used from
all workstations to point to the alternate folders, including the server if
it is used as a workstation.

If you need to use the same drive letter on the server as on the
workstation because you have moved company data to an alternate
location, create a drive mapping to the share point on the server. Do not
use the SUBST command.
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Installing Sage ERP MAS 200

Read this guide completely before installing and setting up Sage ERP
MAS 200. A series of procedures must be completed for new
installations. When upgrading a system, there are additional
post-installation requirements for migrating existing data and
converting it to the current version.

Installation Requirements

Sage ERP MAS 200 uses the TCP/IP protocol for all communications
between the workstation and server. To run Sage ERP MAS 200,
TCP/IP must be properly configured on both the Windows Server
and all workstations that will run Sage ERP MAS 200 on the server.
For more information, see TCP/IP Protocol on page 153.

If you are installing Sage ERP MAS 200 on a Windows Server with
Terminal Services enabled, see Terminal Services Considerations on
page 156.

The server where you are installing Sage ERP MAS 200 should have a
minimum of 750 MB of free disk space, depending on the number of
applications to be installed. Verify that you have 600 MB of disk space
available for System Setup and Library Master, plus an additional 15
to 25 MB for each module to be installed.

For information on the specific operating system requirements, see

the Supported Platform Matrix in the Support area of the Sage Online
Web site at: www.sagesoftwareonline.com
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Pre-Installation Tasks
Perform these tasks before beginning the installation process.

¢ If you are upgrading from a prior version, read the Customer Upgrade
Guide, which is available on the Sage ERP MAS product DVD.

e Verify that you have your packing list, which includes the serial number,
customer number, user key, and product key, which are required to
install Sage ERP MAS 200 for the correct number of users and to register
the modules. This information is also available on the Sage Online Web
page under Profile Mgmnt > Products.

¢ Test and validate all of the hardware and network configurations using
the following resources, which can be found in the Support area of the
Sage Online Web site at: www.sagesoftwareonline.com

* The Supported Platform Matrix
¢ The Integrated Solutions Compatibility Matrix
¢ The current support library

A WARNING * If you are upgrading from Sage ERP MAS 200 version 4.40, determine

If you are upgrading whether to perform a parallel installation or an in-place installation.
from version 4.30 or

earlier, youmust ¢ [f you will be installing the Sage Web Engine, verify that IIS is installed

install Sage ERP d .
MAS 200 version and running.

4.50 to a new
location and then @ If a prior version of the Sage Web Engine is installed for the eBusiness

perform a parallel Manager module, back up any customized templates in the IW folder to
”:)'g:a;g;itr? ”:j'gtr:te another location, and then uninstall the Sage Web Engine. After the 4.50
g 9 det Sage Web Engine is installed, move the templates back to the IW folder.

¢ If you are installing the Payroll module, you must also install the Payroll
Tax Table. Failure to install the Payroll Tax Table will cause a FILE
PRU.SOA NOT FOUND message to appear when Payroll is first set up
for a company.

¢ Configure TCP/IP as a protocol on your server and workstations. All
workstations must be able to ping the server and vice versa. For
information on pinging the server, see Basic Configuration on page 153.
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¢ Third-party applications used with Sage ERP MAS 200 may require a
drive mapping or UNC to the server where the data files are located.
This drive must be mapped to a share point on the server above the
MAS90 folder. Although Sage ERP MAS 200 itself does not require a
logical drive mapping, any application written to access the data files
(including third-party or Sage developer partner applications) must
have a valid logon to the server and may require a logical drive mapping
or UNC.

* If you are installing SageCRM, create a Windows user account with
permissions to access both the server where Sage ERP MAS 200 will be
installed and the SQL Server database. This account is used by the
Integration Engine to send data between the Sage ERP MAS 200 server
and the SageCRM server. You are asked to provide this information
during the Sage ERP MAS 200 installation if the Customer Relationship
Management module is selected for installation. For more information,
see Installing SageCRM on page 43.

Installation Process

Run the Sage ERP MAS 200 installation wizard program to install a new
instance of Sage ERP MAS 200 or to upgrade your system from a prior
version. The installation wizard guides you through the installation.

To install Sage ERP MAS 200

1 Log on to the server where Sage ERP MAS 200 will be installed using an
account with administrator rights. You must run the Setup program
from the Windows server, not from a workstation connected to the

server.

é 2 Close down other programs. Do not close antivirus, antispyware, and
NOTE script-blocking software unless it is actually interfering with the

When specifying . R

where to installl installation.

Sage ERP MAS, do

not nest a 3 Place the Sage ERP MAS product DVD in the DVD.

destination folder in

folders named 4 If Autorun is enabled on the server, the Autorun screen appears;

MAS90 or SOA. otherwise, select Windows Start menu > Run and type D:\ Autorun.exe,

where D:\ is the DVD drive. The wizard must be launched from the
Autorun screen, not from the individual setup files on the DVD.
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5 On the Autorun screen, click Sage ERP MAS 200.
6 On the Sage ERP MAS 200 screen, click Install Sage ERP MAS 200.

7 Follow the steps in the installation wizard to install a new instance or
upgrade an existing installation.

& Note The time required for installing depends on the number of modules

If a message dialog selected. If several modules are installed, this process may take several

box appears asking Mminutes.

you to restart the

computer, youmust  If you receive a message stating that no installation of Adobe Acrobat

ﬁ;;ﬂ:f;ﬁrvevﬁrge Reader was detected, click OK to continue with the installation. After the

fully functional. installation is complete, the Sage ERP MAS 200 screen appears. Click
Productivity Applications, and then click Install Acrobat Reader to install
the application. For more information, see Productivity Applications on
page 27.

Post-Installation Tasks
Perform the following tasks after installing Sage ERP MAS 200.
1 If you are upgrading, refer to your Customer Upgrade Guide.

2 Install any version 4.50 product updates available on the Sage Online
Web site at: www.sagesoftwareonline.com

3 Create a share at least one folder above the MAS90 folder. This is
required before running Workstation Setup. For more information, see
Sage ERP MAS Security Permissions on page 145.

4 Setup and run the Application Server (see Using the Application Server
on page 59).

5 Install SageCRM if you plan to use that product (see Installing
SageCRM on page 43).

6 To run Microsoft Script links, you must have the Microsoft Windows
Script Host processor on your system. For information on installing the
Microsoft Windows Script Host processor, refer to the Microsoft
Download Center Web site.
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7 Run Workstation Setup on any workstations that will access the Sage
ERP MAS 200 installation (see Workstation Setup on this page).

8 Install optional productivity applications, such as Crystal Reports
Designer, on each workstation as needed. Installing Crystal Reports
Designer is necessary only if you plan to create or modify reports.

9 If you are installing Federal and State eFiling and Reporting, you must
install it on each Sage ERP MAS 200 workstation. For more information,
see Installing Federal and State eFiling and Reporting on page 89.

10 Create companies and activate modules (see Creating and Activating
Companies on page 98).

11 Create roles and user codes, and set up system preferences (see Setting
Up Roles and Users for Security on page 104).

12 Set up the modules for your companies. If you are converting your
existing business management system to Sage ERP MAS 200, assemble
the data you need to set up each module. For more information, refer to
your Getting Started Guide.

Workstation Setup

& The Workstation Setup wizard installs the required software and common
NoTE . . ..

Run the programs to the workstations that will access the Application Server
Workstation Setup  installation. The workstation installation wizard copies all of the necessary
program after every Dynamic Link Libraries, ActiveX controls, and other components to the

Sage ERP local Windows\System folder and sets up the initialization files for the
MAS 200 software X
upgrade. workstation.

Workstation Setup Requirements

Do not install workstation components to a server or to a shared
installation. Each workstation must have its own set of workstation
components on a local hard drive.
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If you are running Sage ERP MAS 200 through Terminal Services or Citrix,
do not run the workstation installation wizard directly at the Terminal
Services or Citrix server. Instead, run the workstation installation wizard
only once through a remote session. Running the workstation installation
wizard from a Terminal Services session will set up the correct registry
entries for Crystal forms and reports access and copy the multi-user
activation file from the Application Server to the Terminal or Citrix server.
For more information, see Running in a Terminal Services or Citrix
Environment on page 155.

Running Workstation Setup

To facilitate ease of installation, the Workstation Setup program should be
run from the server where Sage ERP MAS 200 is installed; however,
running the program from the product DVD may be faster for remote users.

é To run Workstation Setup

NoTE

If you have multiple L. .

ingtalﬁati(\,/ns o:cjt;]i Close down other programs. Do not close antivirus, antispyware, and
same version of script-blocking software unless it is actually interfering with the

Sage ERP installation.

MAS 200, see

Multiple . .

Installations on 2 Connect to the server using the UNC to the share point where Sage ERP

page 24. MAS 200 is installed.
3 Perform one of the following to start the installation:

¢ To run the Workstation Setup wizard from the Sage ERP MAS 200
installation folder (the preferred method):

a Use Windows Explorer to attach to the server share point where
Sage ERP MAS 200 is installed, and locate the MAS90\ Wksetup
folder.

b Double-click Wksetup.exe to run the program; it takes a few
seconds to launch.
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* To run the Workstation Setup wizard from the Sage ERP MAS
product DVD:

a Place the Sage ERP MAS product DVD in the DVD drive. If
Autorun is enabled on the computer, the Sage ERP MAS Autorun
screen appears. If the Autorun screen does not appear, on the
Windows Start menu, select Run, and type D:\ Autorun.exe where
D:\ is the DVD drive.

b On the Autorun screen, click Sage ERP MAS 200.

¢ On the Sage ERP MAS 200 page, click Install Sage ERP MAS 200
Workstation.

4 Follow the steps in the Workstation Setup wizard.

& Note If you receive a message stating that no installation of Adobe Acrobat
If a message dialog Reader was detected, click OK to continue with the installation. After the
box appears asking installation is complete, the Sage ERP MAS 200 screen appears. Click
youtorestartthe  Productivity Applications, and then click Install Acrobat Reader to install

32";2”;2;6?’:;:““ the application. For more information, see Productivity Applications on

installation will be ~ Pa8&€ 27.

fully functional.
If you are running through Terminal Services/Citrix, you are prompted to

indicate whether Sage ERP MAS 200 will be accessed through Terminal
Server. Click Yes to copy the activation key file. This allows multiple
Terminal Services/Citrix sessions to access Sage ERP MAS 200 at the same
time. Click No to leave the activation set for a single user. If you typed NO
ACCESS at the Server field in the Sage ERP MAS 200 Server Path page, this
message does not appear.
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Multiple Installations

A Sage ERP MAS 200 workstation can attach to multiple servers. For
example, if your site has three servers and Sage ERP MAS 200 is installed
on each server, you can connect to the appropriate server by clicking a
single icon rather than having a separate icon for each installation.

Selecting a Server

If the Workstation Setup wizard has been run for only one server, your
system is configured automatically for that server. Running the Workstation
Setup wizard again (from a different server path) allows you to select from
multiple servers using the same workstation files. If multiple servers are
found in your local configuration file, a dialog box similar to the following

appears.

[i% Select Server g@g|
Server Name/Alias | Application Server | Socket Number ‘ Application |
ARTEMIS SAGE 9027 MAS 200
MNOUEHI BAGE 10000 Mas 200

The dialog box lists both the server name and the socket number on which
the program is running. Select the server and socket number pair to which
to attach and click OK. If you do not want to start Sage ERP MAS 200, click
Cancel to terminate the program. You cannot have multiple installations of
the Sage ERP MAS 200 server component on the same server.
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Editing, Adding, and Removing Servers

Use the Select Server window to edit, add, or remove entries in the window
by clicking the appropriate button. Clicking Add displays a window similar
to the following in which you can enter a server name, alias, and socket

number.
(2% Add Server, X
Server artemis
Aliss Alternate Installation
Socket No
Server Path Shartemishappsimas S0

Application Server

Application Mame

After all the information is entered, click Accept to save the entry or click
Cancel to return to the main selection window without adding this server
entry.

The Edit feature functions similarly to the Add feature, except that the
window contains all of the current information about the server and port
ID. The Edit Server window can be used to modify existing data or change
the socket number, if necessary. Click Remove in the Select Server window
to remove the server entry from the configuration file.

Aliasing a Server

It may be practical to assign an alias to the server and socket number pairs.
For example, you can label one installation as “Accounting” and a second
installation as “Payroll.” You can assign an alias to any server and socket
number pair in the list of installed servers by clicking Alias in the Select
Server window.
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Select the server and socket number pair to alias by selecting the line and
clicking Alias. The following window appears.

(% Change Server Alias

Enter alias for server artemis [Socket No. 10000]

Type the name of the alias to use for this server and socket number, and
click Accept. If you do not want to alias this server, click Cancel.

The aliases associated with servers are local to each individual workstation.
The configuration information is stored in the SOTA.INI file located in the
\MAS90\ Launcher folder. To use the same configuration files on multiple
workstations, copy the SOTA.INI file to each workstation's

\MAS90\ Launcher folder.

Setting a Default Server

When multiple servers are present, you may want to set a default server
and port ID to start up. Even if the server and port are set to Default, the
Select Server window always appears; however, the selected server is the
one chosen as the default. Click OK to start Sage ERP MAS 200 on the
default server.

To set a server and socket number as the default, select the server and
socket number pair by clicking the line, and selecting the Default check box.
When Sage ERP MAS 200 is started from this workstation, the server and
socket number selected as the defaults are highlighted.
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Productivity Applications

The following third-party applications are required to perform certain tasks
on the workstation. These applications can be installed from the
Productivity Applications screen on the Sage ERP MAS product DVD.

* Adobe Acrobat Reader is needed to view Paperless Office documents,
the online user guides, the module report samples, and module
overview PDFs in the Help system.

e Crystal Reports Designer must be installed on each workstation where
reports will be created or modified. For more information, see Installing
Crystal Reports Designer on page 77.

Third-Party Applications for SageCRM

The following third-party applications are required to perform certain
SageCRM tasks on the workstation.

* Mail Merge Plug-In is required to use the mail merge functionality. The
first time a user encounters one of the features requiring the plug-in (for
example, the My CRM menu > Calendar page displaying the Document
Drop icon), they are prompted to download the plug-in. Instructions are
provided on-screen. The user must be an administrator or power user of
the client machine to install the Mail Merge Plug-In. The client browser
must also be configured to accept plug-ins.

* Microsoft Office Applications are required for users who will be using
the mail merge and document merge features supported by SageCRM;
Microsoft Word and Excel should be installed on the workstation. The
data upload feature accepts files in XLS format, created by Microsoft
Excel.

* Microsoft Internet Explorer is required for users to access the SageCRM
software.
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* Outlook Plug-In is required for SageCRM Outlook Integration. Users
can download the Outlook Plug-In from within SageCRM in the My
CRM menu > Preferences tab. The user must be an administrator or
power user of the client machine to install the Outlook Plug-In.

If installing SageCRM Outlook Integration in a Terminal Services
environment, administrator rights are required on the Terminal Services
computer. All instances of Internet Explorer and Outlook must be closed
to install the plug-in. At the time of the installation, exclusive access to
the server is required for each user. After the plug-in is installed,
administrator rights are no longer required.
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Installing Sage ERP MAS 200 SQL

Read this guide completely before installing and setting up Sage ERP
MAS 200 SQL. A series of procedures must be completed for new
installations. When upgrading a system, there are additional
post-installation requirements for migrating existing data and
converting it to the current version.

Installation Requirements

Microsoft SQL Server must be installed before installing Sage ERP
MAS 200 SQL. Sage supports the installation of Sage ERP

MAS 200 SQL and SQL Server on the same server as well as the
installation of the two products on separate servers. For information
on the version of Microsoft SQL Server available through Sage, see
Microsoft SQL Server Runtime Edition 2008 on page 30.

Sage ERP MAS 200 SQL uses the TCP/IP protocol for all
communications between the workstation and server. To run Sage
ERP MAS 200 SQL, TCP/IP must be properly configured on both the
Windows Server and all workstations that will run Sage ERP

MAS 200 SQL on the server. For more information, see TCP /1P
Protocol on page 153.

If you are installing Sage ERP MAS 200 SQL on a Windows Server
with Terminal Services enabled, see Terminal Services Considerations
on page 156.

The server where you are installing Sage ERP MAS 200 SQL should
have a minimum of 750 MB of free disk space, depending on the
number of applications to be installed. Verify that you have 600 MB of
disk space available for System Setup and Library Master, plus an
additional 15 to 25 MB for each module to be installed.

For information on the specific operating system requirements, see

the Supported Platform Matrix in the Support area of the Sage Online
Web site at: www.sagesoftwareonline.com
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Microsoft SQL Server Runtime Edition 2008

If you purchased SQL Server directly from Sage, you will receive a separate
installation DVD for Microsoft SQL Server Runtime Edition 2008. The only
difference between this version and SQL Server 2008 Standard Edition is
that Microsoft SQL Server Runtime Edition 2008 can be used only with Sage
products. The performance of the two versions is the same, both come with
the same database administration tools, and neither have restrictions on the
database size.

Installation Requirements

Microsoft .NET Framework 3.5 is required and is included on the SQL
Server installation DVD. If you select the Sage Configured installation type,
NET Framework 3.5 will be automatically installed if the installation
wizard detects that your system has an older version.

Windows Installer 4.5 or higher is required and is included on the SQL
Server installation DVD. If you select the Sage Configured installation type,
Windows Installer 4.5 will be automatically installed if the installation
wizard detects that your system has an older version.

SQl Server Installation Types

There are two installation types available: Sage Configured and Advanced.
The Sage Configured option allows you to bypass the Microsoft SQL Server
Setup program; SQL Server will automatically be optimally configured for
Sage ERP MAS 200 SQL. For information on how parameters are defined,
see Sage Configured Installation for SQL Server on page 159.

If you select the Advanced installation option, you will exit the Sage
installation wizard. The Microsoft SQL Server Setup program’s Autorun
screen will appear, and you can use that program to configure and install
SQL Server.

If the installation wizard detects an existing SQL Server installation, you
will have only the Advanced installation option.
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Microsoft SQL Server Runtime Edition 2008 Installation
Process

If you purchased SQL Server from Sage, follow the steps below to perform
the installation.

To install SQL Server

1 Log on to the server, and close down other programs. Do not close
antivirus, antispyware, and script-blocking software unless it is actually
interfering with the installation..

A WARNING

If you install SQL 2 Place the Microsoft SQL Server Runtime Edition 2008 DVD in the DVD
Server or Sage ERP drive.

MAS 200 SQL on a

server with an 3 If Autorun is enabled on the server, the Microsoft SQL Server Runtime

unsupported Edition 2008 Autorun screen appears; otherwise, select Windows Start

operating system,
Sage Customer
Support will be
unable to assistyou 4 On the Autorun screen, click Install Microsoft SQL Server Runtime

if you encounter any Edition 2008.
problems.

menu > Run and type D:\ Autorun.exe where D:\ is the DVD drive.

A message dialog box appears if SQL Server is already installed on your
system. The Sage Configured installation type will be unavailable; you
must use the Advanced SQL Server Installation option.

5 Follow the steps in the installation wizard to install SQL Server. If you
select the Advanced SQL Server Installation, you will use the Microsoft
SQL Server Setup program to configure and install SQL Server.

& Note If one or more of the required components are missing from your server,
The SQL Server a message dialog box appears. Click Yes to install the missing

2008 Setup wind . : . .
etup window components, or click No to exit the installation process.
appears during the

installation, which
may take uptoan 6 If you are prompted to restart your system after components are

hour. installed, remove the installation DVD from the DVD drive, restart the
computer, and then reinsert the DVD to resume the installation.
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Pre-Installation Tasks
Perform these tasks before installing Sage ERP MAS 200 SQL.

¢ If you are upgrading from a prior version, read the Customer Upgrade
Guide, which is available on the Sage ERP MAS product DVD.

e Verify that you have your packing list, which includes the serial number,
customer number, user key, and product key, which are required to
install Sage ERP MAS 200 SQL for the correct number of users and to
register the modules. This information is also available on the Sage
Online Web page under Profile Mgmnt > Products.

¢ Test and validate all of the hardware and network configurations using
the following resources, which can be found in the Support area of the
Sage Online Web site at: www.sagesoftwareonline.com

* The Supported Platform Matrix
¢ The Integrated Solutions Compatibility Matrix
¢ The current support library

¢ If you are upgrading from Sage ERP MAS 200 SQL version 4.45,
determine whether to perform a parallel installation or an in-place
installation.

* Configure TCP/IP as a protocol on your server and workstations. All
workstations must be able to ping the server and vice versa. For
information on pinging the server, see Basic Configuration on page 153.

¢ Third-party applications used with Sage ERP MAS 200 SQL may require
a drive mapping or UNC to the server where the data files are located.
This drive must be mapped to a share point on the server above the
MAS90 folder. Although Sage ERP MAS SQL itself does not require a
logical drive mapping, any application written to access the data files
(including third-party or Sage developer partner applications) must
have a valid logon to the server and may require a logical drive mapping
or UNC.
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¢ If you are installing SageCRM, create a Windows user account with
permissions to access both the server where Sage ERP MAS 200 SQL will
be installed and the SQL Server database. This account is used by the
Integration Engine to send data between the Sage ERP MAS 200 SQL
server and the SageCRM server. You are asked to provide this
information during the Sage ERP MAS 200 SQL installation if the
Customer Relationship Management module is selected for installation.
For more information, see Installing SageCRM on page 43.

Sage ERP MAS 200 SQl Installation Process

Run the Sage ERP MAS 200 SQL installation wizard program to install a
new instance of Sage ERP MAS 200 SQL or to upgrade your system from a
prior version. The installation wizard guides you through the installation.

To install Sage ERP MAS 200 SQL

1 Log on to the server where Sage ERP MAS 200 SQL will be installed
using an account with administrator rights. You must run the Setup
program from the Windows server, not from a workstation connected to
the server.

2 Close down other programs. Do not close antivirus, antispyware, and
script-blocking software unless it is actually interfering with the
installation.

3 DPlace the Sage ERP MAS product DVD in the DVD drive.

4 If Autorun is enabled on the server, the Autorun screen appears;

é otherwise, select Windows Start menu > Run and type D:\ Autorun.exe
WhenNsopZEfymg where D:\ is the DVD drive. The wizard must be launched from the
where to install Autorun screen, not from the individual setup files on the DVD.

Sage ERP MAS, do

not nest a 5 On the Autorun screen, click Sage ERP MAS 200 SQL.

destination folder in

;;’fg;% ”a”;‘i;’A 6 On the Sage ERP MAS 200 SQL screen, click Install Sage ERP
o MAS 200 SQL.

7 A message dialog box appears if the operating system on the server is

not supported. Click Yes to continue with the installation or click No to
cancel the installation.
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8 Follow the steps in the installation wizard to install a new instance or
upgrade an existing installation.

& Note The time required for installing depends on the number of modules
If a message dialog Selected. If several modules are installed, this process may take several

box appears asking minutes.

you to restart the

gg”;g“;;;’g‘t‘hrg“S‘t If you receive a message stating that no installation of Adobe Acrobat

installation will e Reader was detected, click OK to continue with the installation. After the

fully functional. installation is complete, the Sage ERP MAS 200 SQL screen appears. Click
Productivity Applications, and then click Install Acrobat Reader to install
the application. For more information, see Productivity Applications on

page 41.

Post-Installation Tasks
Perform the following tasks after installing Sage ERP MAS 200 SQL.
1 If you are upgrading, refer to your Customer Upgrade Guide.

2 Install any version 4.50 product updates available on the Sage Online
Web site at: www.sagesoftwareonline.com

3 Create a share at least one folder above the MAS90 folder. This is
required before running Workstation Setup. For more information, see
Sage ERP MAS Security Permissions on page 145.

4 Set up and run the Application Server (see Using the Application Server
on page 59).

5 Install SageCRM if you plan to use that product (see Installing
SageCRM on page 43).

6 To run Microsoft Script links, you must have the Microsoft Windows
Script Host processor on your system. For information on installing the
Microsoft Windows Script Host processor, refer to the Microsoft
Download Center Web site.

7 Run Workstation Setup on any workstations that will access the Sage
ERP MAS 200 SQL installation (see Workstation Setup on page 35).
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8 Install optional productivity applications, such as Crystal Reports
Designer, on each workstation as needed. Installing Crystal Reports
Designer is necessary only if you plan to create or modify reports.

9 If you are installing Federal and State eFiling and Reporting, you must
install it on each Sage ERP MAS 200 SQL workstation. For more
information, see Installing Federal and State eFiling and Reporting on
page 89.

10 Create companies and activate modules (see Creating and Activating
Companies on page 98).

11 Create roles and user codes, and set up system preferences (see Setting
Up Roles and Users for Security on page 104).

12 Set up the modules for your companies. If you are converting your
existing business management system to Sage ERP MAS 200 SQL,
assemble the data you need to set up each module. For more
information, refer to your Getting Started Guide.

Workstation Setup

& Note The Workstation Setup wizard installs the required software and common
Run the programs to the workstations that will access the Application Server
Workstation Setup  installation. The workstation installation wizard copies all of the necessary
program after every Dynamic Link Libraries, ActiveX controls, and other components to the
Sage ERP local Windows\System folder and sets up the initialization files for the

MAS 200 SQL .
software upgrade. workstation.

Workstation Setup Requirements

Do not install workstation components to a server or to a shared
installation. Each workstation must have its own set of workstation
components on a local hard drive.
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If you are running Sage ERP MAS 200 SQL through Terminal Services or
Citrix, do not run the workstation installation wizard directly at the
Terminal Services or Citrix server. Instead, run the workstation installation
wizard only once through a remote session. Running the workstation
installation wizard from a Terminal Services session will set up the correct
registry entries for Crystal forms and reports access and copy the
multi-user activation file from the Application Server to the Terminal or
Citrix server. For more information, see Running in a Terminal Services or
Citrix Environment on page 155.

Running Workstation Setup

To facilitate ease of installation, the Workstation Setup program should be
run from the server where Sage ERP MAS 200 SQL is installed; however,
running the program from the product DVD may be faster for remote users.

é To run Workstation Setup
NOTE

If you have multiple

installations of the 1 Close down other programs. Do not close antivirus, antispyware, and

same version of script-blocking software unless it is actually interfering with the

Sage ERP installation.

MAS 200 SQL, see

Multiple 2 Connect to the server using the UNC to the share point where Sage ERP
Installations on

page 38. MAS 200 SQL is installed.
3 Perform one of the following to start the installation:

¢ To run the Workstation Setup wizard from the Sage ERP MAS 200
installation folder (the preferred method):

a Use Windows Explorer to attach to the server share point where
Sage ERP MAS 200 SQL is installed, and locate the
MAS90\Wksetup folder.

b Double-click Wksetup.exe to run the program; it takes a few
seconds to launch.
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* To run the Workstation Setup wizard from the Sage ERP MAS
product DVD:

a Place the Sage ERP MAS product DVD in the DVD drive. If
Autorun is enabled on the computer, the Sage ERP MAS Autorun
screen appears. If the Autorun screen does not appear, on the
Windows Start menu, select Run, and type D:\ Autorun.exe where
D:\ is the DVD drive.

b On the Autorun screen, click Sage ERP MAS 200 SQL.

¢ On the Sage ERP MAS 200 SQL page, click Install Sage ERP
MAS 200 SQL Workstation.

4 Follow the steps in the Workstation Setup wizard.

Vi If you receive a message stating that no installation of Adobe Acrobat

fa m’;';;';e dialog Reader was detected, click OK to continue with the installation. After the
box appears asking installation is complete, the Sage ERP MAS 200 SQL screen appears. Click
youtorestartthe  Productivity Applications, and then click Install Acrobat Reader to install

computer, youmust  the application For more information, see Productivity Applications on
do so before the page 41

installation will be

fully functional. . . . L.
If you are running through Terminal Services/Citrix, you are prompted to

indicate whether Sage ERP MAS 200 SQL will be accessed through
Terminal Server. Click Yes to copy the activation key file. This allows
multiple Terminal Services/Citrix sessions to access Sage ERP

MAS 200 SQL at the same time. Click No to leave the activation set for a
single user. If you typed NO ACCESS at the Server field in the Sage ERP
MAS 200 SQL page, this message does not appear.
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Multiple Installations

A Sage ERP MAS 200 SQL workstation can attach to multiple servers. For
example, if your site has three servers and Sage ERP MAS 200 SQL is
installed on each server, you can connect to the appropriate server by
clicking a single icon rather than having a separate icon for each
installation.

Selecting a Server

If the Workstation Setup wizard has been run for only one server, your
system is configured automatically for that server. Running the Workstation
Setup wizard again (from a different server path) allows you to select from
multiple servers using the same workstation files. If multiple servers are
found in your local configuration file, a dialog box similar to the following

appears.

[i% Select Server g@g|
Server Name/Alias | Application Server | Socket Number ‘ Application |
ARTEMIS SAGE 9027 MAS 200
MNOUEHI BAGE 10000 Mas 200

The dialog box lists both the server name and the socket number on which
the program is running. Select the server and socket number pair to which
to attach and click OK. If you do not want to start Sage ERP MAS 200 SQL,
click Cancel to terminate the program. You cannot have multiple
installations of the Sage ERP MAS 200 SQL server component on the same
server.
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Editing, Adding, and Removing Servers

Use the Select Server window to edit, add, or remove entries in the window
by clicking the appropriate button. Clicking Add displays a window similar
to the following in which you can enter a server name, alias, and socket

number.
(2% Add Server, X
Server artemis
Aliss Alternate Installation
Socket No
Server Path Shartemishappsimas S0

Application Server

Application Mame

After all the information is entered, click Accept to save the entry or click
Cancel to return to the main selection window without adding this server
entry.

The Edit feature functions similarly to the Add feature, except that the
window contains all of the current information about the server and port
ID. The Edit Server window can be used to modify existing data or change
the socket number, if necessary. Click Remove in the Select Server window
to remove the server entry from the configuration file.

Aliasing a Server

It may be practical to assign an alias to the server and socket number pairs.
For example, you can label one installation as “Accounting” and a second
installation as “Payroll.” You can assign an alias to any server and socket
number pair in the list of installed servers by clicking Alias in the Select
Server window.
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Select the server and socket number pair to alias by selecting the line and
clicking Alias. The following window appears.

(% Change Server Alias

Enter alias for server artemis [Socket No. 10000]

Type the name of the alias to use for this server and socket number, and
click Accept. If you do not want to alias this server, click Cancel.

The aliases associated with servers are local to each individual workstation.
The configuration information is stored in the SOTA.INI file located in the
\MAS90\ Launcher folder. To use the same configuration files on multiple
workstations, copy the SOTA.INI file to each workstation's

\MAS90\ Launcher folder.

Setting a Default Server

When multiple servers are present, you may want to set a default server
and port ID to start up. Even if the server and port are set to Default, the
Select Server window always appears; however, the selected server is the
one chosen as the default. Click OK to start Sage ERP MAS 200 SQL on the
default server.

To set a server and socket number as the default, select the server and
socket number pair by clicking the line, and selecting the Default check box.
When Sage ERP MAS 200 SQL is started from this workstation, the server
and socket number selected as the defaults are highlighted.
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Productivity Applications

The following third-party applications are required to perform certain tasks
on the workstation. These applications can be installed from the
Productivity Applications screen on the Sage ERP MAS product DVD.

* Adobe Acrobat Reader is needed to view Paperless Office documents,
the online user guides, the module report samples, and module
overview PDFs in the Help system.

e Crystal Reports Designer must be installed on each workstation where
reports will be created or modified. For more information, see Installing
Crystal Reports Designer on page 77.

Third-Party Applications for SageCRM

The following third-party applications are required to perform certain
SageCRM tasks on the workstation.

* Mail Merge Plug-In is required to use the mail merge functionality. The
first time a user encounters one of the features requiring the plug-in (for
example, the My CRM menu > Calendar page displaying the Document
Drop icon), they are prompted to download the plug-in. Instructions are
provided on-screen. The user must be an administrator or power user of
the client machine to install the Mail Merge Plug-In. The client browser
must also be configured to accept plug-ins.

* Microsoft Office Applications are required for users who will be using
the mail merge and document merge features supported by SageCRM;
Microsoft Word and Excel should be installed on the workstation. The
data upload feature accepts files in XLS format, created by Microsoft
Excel.

* Microsoft Internet Explorer is required for users to access the SageCRM
software.
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* Outlook Plug-In is required for SageCRM Outlook Integration. Users
can download the Outlook Plug-In from within SageCRM in the My
CRM menu > Preferences tab. The user must be an administrator or
power user of the client machine to install the Outlook Plug-In.

If installing SageCRM Outlook Integration in a Terminal Services
environment, administrator rights are required on the Terminal Services
computer. All instances of Internet Explorer and Outlook must be closed
to install the plug-in. At the time of the installation, exclusive access to
the server is required for each user. After the plug-in is installed,
administrator rights are no longer required.
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Installing SageCRM

The SageCRM server(s) host the SageCRM program files, Internet
Information Services (IIS) Web Server, and SQL Server database.
These components should be installed on a separate server from the
one with Sage ERP MAS installed. Depending on the number of users
accessing the SageCRM server, it may be necessary to split the
SageCRM SQL Server database and the IIS Web server across two or
more machines.

Only one company in your Sage ERP MAS software can be integrated
with a single SageCRM database. If you are integrating multiple
companies with SageCRM, a separate SageCRM installation, key, and
database are required for each company you are integrating.

Hardware Requirements

These guidelines are for call center-type users on a non-customized
system. Product customizations can significantly impact the
performance of SageCRM and should be carefully evaluated when
specifying hardware.

* For the Web server, disk mirroring (RAID 1) is recommended. For
the database server, a RAID 10 disk array system is strongly
recommended. RAID 10 allows you to swap out a failed drive
with minimal disruption to your production environment and
improves performance. Larger sites should consider the use of a
fiber channel SAN.

¢ Each site must have adequate backup and recovery capabilities.
® An Uninterruptible Power Supply is recommended.

* A "hot standby" system with a backup database is recommended.
This standby system should have a very similar configuration to
the primary production system, and can also be used for
development and testing.
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* The amount of disk space required varies based on the number of
customer records, archiving plans, and backup policies. The disk space
can also vary based on the amount of data stored for each customer.
Estimate disk space needs before installation to allow for significant
growth in the volume of data.

* Keep in mind the type of user who will be working with the system. For
example, 200 call center users use the system more intensively than 200
sales and marketing users.

Using Multiple Servers

Follow these guidelines for determining the number of SageCRM servers to
use. You should use test servers to replicate your intended server
configuration before using live data.

¢ If your installation will be accessed by fewer than 50 users and the
database size is less than 2GB, the database and Web server can be
located on the same machine. The machine should have two dual core
processors.

¢ If your installation will be accessed by more than 50 users, split the
database server and Web server across two machines. The machines
should each have two dual core processors.

* If your installation will be accessed by more than 200 users, use
high-specification processors in each machine. If your installation will
be accessed by several hundred users, multi-server SageCRM should be
considered.

Software Requirements

Only Microsoft SQL Server databases are supported. SQL Server must be

& NOTE installed on the database server before SageCRM is installed. Microsoft
Microsoft SQL Internet Information Services (IIS) must also be installed on the Web server.
Server Expressis  This guide assumes that you understand the SQL Server and IIS Web server

not supported. .
environments.

SageCRM connects to the database using Microsoft Data Access
Components (MDAC). If MDAC or its latest version is not already installed
on your system, it is installed as part of setup.
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Java 2 Runtime Environment is required; if it is not installed on the server,
you are prompted to install it. You must then restart your system for Java 2
Runtime Environment changes to take effect. This software is required for
the FOP software to function.

Microsoft .NET Framework is required; if it is not installed on the server,
you are prompted to install it. This component is required for SageCRM.

Pre-Installation Tasks

Perform these tasks before beginning the installation process.

* Ideally, Sage ERP MAS 90, 200, or 200 SQL should be installed before
installing SageCRM (see Installing Sage ERP MAS 90 on page 7,
Installing Sage ERP MAS 200 on page 17, or Installing Sage ERP
MAS 200 SQL on page 29).

e If you are upgrading from a prior version of SageCRM, you must
remove all third-party customizations before beginning the upgrade.
Contact your Sage business partner for assistance. For further
information, see Upgrading SageCRM on page 48.

* Determine the name of the database server you will install to and the
port number that SQL Server is using for TCP/IP connectivity.

¢ If the Customer Relationship Management module was selected when
installing Sage ERP MAS, the Integration Engine should have been
automatically started. If it is not running, perform the following steps to
start it:

a Select Windows Start menu > All Programs > Administrative Tools >
Services.

b In the Services window, select Sage MAS 90 and 200 Integration
Engine. Click the Start Service button.
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Tasks to perform if installing on a Windows 2008 Server Network

Perform the following pre-installation tasks if you are installing SageCRM
on a Windows 2008 Server Network:

e Install the following server roles, if not already installed.
e ASPNET
e ASP (set Enable Parent Paths to True)
¢ ISAPI Extensions
¢ Windows Authentication (if Auto Logon is used)
¢ [IS 6 Management Console
e [IS 6 Management Compatibility

¢ InIIS, ensure that the Anonymous Authentication Credentials are either
using Application Pool Identity or are hard-coded with a local
administrator account.

* If Windows Firewall is used, set the Incoming connections option to
Allowed.

* Verify that the Application Server port ID is open, and create an inbound
rule, if necessary.

* Verify that the SQL Server port ID is open, and create an inbound rule, if
necessary.

* Verify that the Integration Engine port ID is open, and create an inbound
rule, if necessary.

¢ If 64-bit is used, run IIS in 32-bit compatibility mode. For more
information, refer to your SageCRM System Administrator Guide.

¢ Perform the DVD installation of SageCRM directly at the server.
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Installation Process

Vi Perform this installation at the server that hosts the IIS Web server. This
Note section refers only to a new installation. For information on upgrading, see

Sage ERP MAS Upgrading SageCRM on page 48.

supports the United
States dollar

currency only. To install SageCRM

1 Go to the IIS Web server where you are installing the SageCRM
software.

2 Close down other programs. Do not close antivirus, antispyware, and
script-blocking software unless it is actually interfering with the
installation.

3 Place the Sage ERP MAS product DVD in the DVD drive of the server.

4 If Autorun is enabled on the server, the Sage ERP MAS Autorun screen
appears; otherwise, select Windows Start menu > Run and type
D:\ Autorun.exe, where D:\ is the DVD drive.

5 On the Autorun screen, select your Sage ERP MAS product.
6 On the product screen, click Install SageCRM 7.1 SP1.

7 If Microsoft NET Framework is not installed on the server, you are
prompted to install it. Click OK to launch and complete the Microsoft
.NET Framework installation wizard.

8 TFollow the steps in the installation wizard to install SageCRM.

AWARNING Note the name of the SageCRM SQL Server database and logon
Stopping the is  information. When setting up the Customer Relationship Management

server disconnects module in Sage ERP MAS, you will be required to provide this information.
all users who are

currently using any  If Internet Information Services (IIS) is running on the server, you are

X\J/?E es::g ZZ:\?:fted prompted to stop IIS before the.installa’-cion process bggins. Cl.ick OK to stop
the IIS server and perform the installation. After the installation has
completed, IIS will be restarted automatically.
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Post-Installation Tasks

Set up the Customer Relationship Management module in your Sage ERP
MAS installation. Sage ERP MAS and SageCRM will not be integrated until
after you set up the module in CRM Options. For more information, see Set
Up Customer Relationship Management for a new Company in the Sage
ERP MAS Help system.

Set up and create users, territories, and security profiles in the SageCRM
software. One SageCRM user must be created for each salesperson defined
in your Sage ERP MAS software. For more information, refer to the
SageCRM System Administrator Guide, which is available in the
CRM\Documentation folder on the Sage ERP MAS product DVD.

Upgrading SageCRM

If your existing installation has third-party customizations, they must be
removed before beginning the upgrade. Contact your Sage business partner
for assistance.

Upgrading from Extended Enterprise Suite 1.3 or 1.4

If you are upgrading from Sage Extended Enterprise Suite version 1.3 or
1.4, you must first install SageCRM 7.0 D2 before upgrading to SageCRM
7.1 SP1 for Sage ERP MAS version 4.50.

For information on upgrading to SageCRM 7.0 D2, see the SageCRM
AWARN'NG Updates section in the Extended Enterprise Suite Support area at Sage

Youmust upgrade 3 jine (www.sagesoftwareonline.com).

Sage ERP MAS
before you can log
into SageCRM. To upgrade from SageCRM version 7.0 D2 to version 7.1 SP1

1 Go to the IIS Web server where you are installing the SageCRM
software.

2 Close down other programs. Do not close antivirus, antispyware, and
script-blocking software unless it is actually interfering with the
installation.

3 Place the Sage ERP MAS product DVD in the DVD drive of the server.
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4 If Autorun is enabled on the server, the Sage ERP MAS Autorun screen
appears; otherwise, select Windows Start menu > Run and type
D:\ Autorun.exe, where D:\ is the DVD drive.

5 On the Sage ERP MAS Autorun screen, select a product, and then click
Install SageCRM 7.1 SP1.

6 On the Install SageCRM 7.1 SP1 screen, select the option to upgrade
from your existing version. The installation wizard may take a few
seconds to launch.

7 Click Next to proceed with the installation.

8 On the page where you select a setup type, select Upgrade Previous
version of CRM.

9 Proceed through the remaining steps to complete the installation.

A message dialog box may appear recommending that any triggers in the

SageCRM database be disabled before the upgrade. The following triggers
have been enabled by Sage to facilitate integration between SageCRM and
Sage ERP MAS; it is not necessary to disable these triggers.

¢ Users - trguUsersSyncMAS90

¢ Company - trguCompanySyncMAS90

¢ Person - trguPersonSyncMAS90

* Address - trguAddressSyncMAS90

¢ Address_Link - trguAddressSyncMAS90

¢ Email - trguEmailSyncMAS90

¢ Phone - trguPhoneSyncMAS90

¢ Opportunity - trguOpportunitySyncMAS90

¢ Custom_Captions - trguCaptionsSyncMAS90
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Upgrading from Extended Enterprise Suite 1.2 or prior

Sage does not support upgrading from versions of Extended Enterprise
Suite prior to version 1.3. If you are on version 1.2 or prior, you must
upgrade to version 1.4 and then update that installation with SageCRM 7.0
D2 before upgrading to SageCRM 7.1 SP1. For more information, refer to
the Extended Enterprise Suite Support area at Sage Online at:
www.sagesoftwareonline.com
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Uninstalling and Reinstalling

Uninstalling Sage ERP MAS requires uninstalling each component
separately. The server and workstation uninstall routines will remove
all program files and registry entries made by the Sage ERP MAS
installation routines. You will have the option of removing Sage ERP
MAS data files if you uninstall the server component. All Sage ERP
MAS client workstation files are removed automatically by the
workstation uninstall program.

Overview of Uninstalling Process

The installation process below describes all the procedures that must
be performed to uninstall Sage ERP MAS.

1 If you are using SageCRM, in Library Master Company
Maintenance, remove all Customer Relationship Management
module data for the Sage ERP MAS company. This step must be
performed for all Sage ERP MAS companies. For more
information, see Remove Data in the Help system.

2 If you are using Sage ERP MAS 90 and 200 Fixed Assets, uninstall
Sage ERP MAS 90 and 200 Fixed Assets from the server and each
workstation. For more information, refer to your Fixed Assets
Installation and System Administrator’s Guide.

3 Uninstall Sage ERP MAS from the Application Server and each
workstation (see Uninstalling the Sage ERP MAS Server
Component on page 52).

4 Uninstall the SageCRM software, if it is installed (see Uninstalling
SageCRM on page 54).
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Uninstalling the Sage ERP MAS Server Component

The uninstall program performs a complete deletion of all Sage ERP MAS
related files. By default, the data files created by Sage ERP MAS are not
removed; however, you will receive an option to remove the data files.

é NOTE To uninstall the server component

If the Integration
Engineis running, 1  Ensure that all users are logged out of the system.
stop the engine

before uninstalling 2 Tn the Windows Control Panel, double-click the Programs and Features
Sage ERP MAS. icon

3 Select the Sage ERP MAS server component from the list. Click
Uninstall to start the uninstall process. If you have more than one
installation of Sage ERP MAS on your server, each installation will be
identified by its installation path.

4 The uninstall splash screen appears briefly and is replaced by the
Confirm Uninstall dialog box. Click OK.

5 The Uninstall Options page appears. Select the type of uninstall to
perform. If you choose to remove a registry entry, you will be removing
the registry entry from all installations of Sage ERP MAS. Click Next.

& Note The uninstall program will begin removing the components of the
When uninstalling server application according to what is contained in the Uninstallation
Sage ERP Log. This includes the following components:

MAS 200 SQL from
the server, the SQL e All system files installed by Sage ERP MAS. This reduces the usage

S _
database is not count of the shared system files, except for core components.
removed. Use the

Microsoft database . . . . .
tools to remove the ¢ All files copied during installation

SQL database.
* The program folder and program items created during installation

* Folders created during installation, specifically the MAS90 folder

If you selected the check box to remove all registry entries, all data folders
will remain in the MAS90 folder. If you select the Remove Company Data
check box, the entire MAS90 folder structure will be deleted.
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If there are any files that the uninstall program was unable to delete, a
message appears stating that you can click the Details button to view a
listing of the files and/or registry entries that could not be removed;
otherwise, a message stating that the uninstallation process was successful
appears. If you choose to retain company data, the uninstall program will
not remove the MAS90 folder created during the installation. This folder
will appear in the Details Listing and is normal.

Uninstalling the Workstation Component

The uninstall process for the Sage ERP MAS workstation component is
similar to the server component uninstall process.

To uninstall the workstation component

1 In the Windows Control Panel, double-click the Programs and Features
icon.

2 Select the Sage ERP MAS workstation component from the list. Click
Uninstall to start the uninstall process.

3 You are prompted to confirm your selection. Click Yes to confirm that
you want to remove the indicated software application. Click No to
cancel this operation.

4 Some registry entries may be needed by other installations of the Sage
ERP MAS workstation; therefore, the uninstall program will prompt
you before removing those entries. If the message dialog box appears,
click Yes to remove the registry entries that are shared with other
installations of Sage ERP MAS on this workstation. Click No to keep
those registry entries.

If there are any files or registry entries that the uninstall program was
unable to delete, a message dialog box appears stating that you can click
Details to view a listing of those files and/or registry entries; otherwise, a
message stating that the uninstallation process was successful appears.
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Uninstalling SageCRM

Before uninstalling, verify that all users are logged out of SageCRM, and
shut down Internet Information Services (IIS). The SageCRM uninstallation
program removes the SageCRM files and SQL database.

To uninstall SageCRM

1 In the Windows Control Panel, double-click the Programs and Features
icon.

2 Select CRM Server, and then click Uninstall.
3 Follow the steps in the wizard to uninstall SageCRM.

4 When the uninstallation is complete, select the View Uninstall Log File
check box to view logging information. Click Finish.

5 Thelog file is displayed. If you need to manually delete any files, details
are specified in the log. Review the log file to make sure there are no
errors. Resolve any errors listed in the log file before reinstalling
SageCRM. Unresolved errors may prevent future installations of
SageCRM from functioning correctly.

Reinstalling the Sage ERP MAS Application Server

If you previously installed the 4.50 version of the software, you can install
over the existing 4.50 installation or install a new copy of the software.
Installing over an existing 4.50 version of the software streamlines the
installation process.

Before reinstalling the Application Server, if the Sage Web Engine is
installed for the eBusiness Manager module, back up any customized
templates in the IW folder to another location, and then uninstall the Sage
Web Engine. After the 4.50 Sage Web Engine is installed, move the
templates back to the IW folder.
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To reinstall the Application Server

1 In the Sage ERP MAS product DVD Autorun screen, select a product.
2 On the product main page, select the option to install that product.

3 Select whether to add, reinstall, update, or uninstall all modules.

* Select Add if you purchased additional modules and are adding
them. You will be required to enter a new product key.

* Select Reinstall to reinstall previously installed modules. The product
key information from the selected installation is used unless the
information is invalid or has expired. You will not be able to enter
new product key information using this option. Proceed to step 4.

* Select Update to update a previous installation of the Application
Server. The product key information from the selected installation is
used unless the information is invalid or has expired. You will not be
able to enter new product key information using this option. If the
information is invalid, see Installing Sage ERP MAS 200 on page 17 to
perform a new installation.

* Select Uninstall to completely uninstall Sage ERP MAS. To uninstall
modules individually, use the System Configuration task on the
Library Master Setup menu. For further information, see
Uninstalling the Sage ERP MAS Server Component on page 52.

4 Select Reinstall and click Next. If the Integration Engine is running, a
message dialog box appears stating that you must stop the Integration
Engine before continuing. Stop the Integration Engine using the
following steps:

a Select Windows Start menu > All Programs > Administrative Tools >
Services.

b In the Services window, select the Integration Engine. Click the Stop
Service button.

5 Inthe message dialog box, click OK.
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6 Proceed through the remaining steps in the installation wizard to
complete the reinstallation.

7 When the reinstallation is complete, restart the Integration Engine using
the following steps:

a Select Windows Start menu > All Programs > Administrative Tools >
Services.

b In the Services window, select the Integration Engine. Click the Start
Service button.

Reinstalling SageCRM

If you previously installed the SageCRM software, the following page
appears after the License Agreement page of the SageCRM installation.

SageCRM 200 Setup 3

Choose Destination Location

Select folder where setup will install files.

“Vou alieady have a copy of SageCRM 200 installed, so please select from the options below,
Sage CRM

© Mew Install

£ Upgrade Previous version of CRM
7 Change existing install of CRM

\ & Complete Beinstal

Destination Folder

C:AProgram FileshSagetCAMY Browse

Inistallshisld < Back Mext > Cancel
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A To reinstall SageCRM
WARNING

Selecting the

Complete Reinstall Select the Complete Reinstall installation option to reinstall over a

option will remove SageCRM installation, and then proceed to the next step.
all data from the
database. 2 If you have more than one SageCRM installation, select the installation

to reinstall. Click Next.

3 Follow the steps in the installation wizard to complete the reinstallation.
For more information, see Installing SageCRM on page 43.

Changing an Existing SageCRM Installation

The SageCRM installation wizard allows you to change specific
components in SageCRM without performing a full reinstallation.
Components you can reinstall are the database, registry, program files, IIS
aliases, and license key. Changing the license key allows you to add features
or increase the number of licensed users.

To change an existing installation of SageCRM
1 Select the Change existing install of CRM option.

2 If you have more than one SageCRM installation, select the installation
to reinstall. Click Next.

3 Follow the steps in the installation wizard to complete the reinstallation.
For more information, see Installing SageCRM on page 43.

If you selected options other than the license key, you are prompted to back
up components that will be affected. Perform the backup before you
proceed.
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Reinstalling the Workstation

If you previously installed the 4.50 version of the software, you can install
over the existing 4.50 installation or install a new copy of the software.
Installing over an existing 4.50 version of the software streamlines the
installation process.

To reinstall the workstation

1 Use Windows Explorer to attach to the server share point where the
Application Server is installed and browse to the MAS90\Wksetup
folder.

2 Inthe Wksetup folder, double-click WkSetup.exe to run the workstation
installation wizard. It takes the workstation installation wizard a few
seconds to launch.

3 Follow the steps in the installation wizard to reinstall the workstation.
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Sage ERP MAS 200 SQL

Application Server Overview

Sage ERP MAS 200 and 200 SQL are powered by the Application
Server, a powerful program that allows multiple users to remotely
access the server using TCP/IP. Users can be connected on an internal
LAN or externally through an intranet or WAN. The Application
Server also allows for encryption using SSL to protect your data if
operating in an environment that is not secure, such as over the
Internet.

Configuring the Application Server

Before you can start Sage ERP MAS 200 or 200 SQL, you must first
configure the Application Server. The Application Server can be
configured to run as a service; it must be configured using the
following steps to access the Sage ERP MAS server.

To configure the Application Server

1 On the server where Sage ERP MAS is installed, from the
Windows Start menu, run the Application Server Configuration
program. This program should be a shortcut in the Sage program
group, unless you installed to a different location.
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2 In the Application Server Configuration window, click the Server tab.

The server selected at this X Application Server Configuration

field is the logical nameto | Et® HeP

Identlfy the AppIication —1 Server |SAGE - Status: | Stopped
Server. This does not refer

to the physical machine Sessions w Server ] Clients ] Apps ] Users ] Service ] Logging ]
name of the server. TCRAP Default User State
Socket: | 10000 :I Disable Servar. [|
Verify the KeepAlives check Keepalives: [] User Name: Disable New Connections: [ ]
box is cleared. Encropt [ User Passward: Disable &ll Connections: [ ]
Certificate: User Domain: Beason:
Options
I:‘ Show Sessions in Taskbar Default Urnask: :I Server's [MI:
D Hee Cmdstlost Start-In Directory:

3 For security purposes, the first setting you should change is the socket
number on which the Application Server listens for requests. By default,
this is set to 10000, but can be any valid socket (port) between 9000 and
10000. Make sure the socket you choose is not being used by another
service or application on this server.

4 Click Start to start the Application Server. In the upper-right corner, the
Status field changes from Stopped to Running. Click Exit to exit the
Application Server Configuration program. Users can now access Sage
ERP MAS after performing workstation setup.

The Application Server continues to run and will service incoming requests
from Sage ERP MAS clients, even though you have exited the Application
Server Configuration program.

In this current configuration, a user must remain logged onto the server
where the Application Server is running. The user logged on to this server
must have access to all resources required by Sage ERP MAS (all rights to
all program and data folders in Sage ERP MAS).

60 Installation and System Administrator's Guide



APPLICATION SERVER OVERVIEW

After the Application Server has been configured once, you do not need to
re-run the Application Server Configuration program to start the
Application Server. You can start the Application Server by selecting the
Application Server Startup menu item from the Windows Start menu. This
starts the Application Server which will continue to run until the user is
logged off or the server is shut down.

To view users currently running Sage ERP MAS and the tasks that users are
running, click the Sessions tab.

% Application Server Configuration E]|§|®

File Help

Server | SAGE - Status: |St0pped |
Sessions ] Server ] Clients ] Apps ] Uszers ] Service ] Logging ]
Uszer Statuz IP Addr Mach.Mame S.FID Connect Time | Application o
109011211 saM2 | 264

10801127
10801127

RLP1
Calz

520
2680

anorymous  Connected

MAS 200

anonymous  Connected Th1m 48z MAS 200

Turning Off the Application Server

There may be instances when you want to turn off the Application Server,
such as before installing an operating system update.

To turn off the Application Server
1 Run the Application Server Configuration program.

2 Click the Servers tab and then click Stop. The Status field changes from
Running to Stopped.
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You can also turn off the Application Server by closing the Application
Server task that appears on the Task Bar of the server. To do this, right-click
the task and click Close from the pop-up menu. The Application Server will
shut down after a few seconds.

Configuring as a Service

Depending on your needs, you may want to start the Application Server as
a service of the operating system. Running as a service has a number of
advantages:

* The Application Server can be configured to start automatically so that if
the server is rebooted, you do not have to re-start the Application Server.

¢ [t is more secure because someone does not need to be logged onto the
server in order for the Application Server to run.

To configure the Application Server as a service

1 Configure the Application Server. For instructions, see Configuring the
Application Server on page 59.

2 Exit the Application Server Configuration program after the
Application Server has been configured.

3 If you already have a Windows domain user account set up to run the
Application Server, skip this step; otherwise, create a new domain user
on your server that has appropriate access rights to run all the functions
and features of Sage ERP MAS. This should include the Modify
permission to the application folder, any folders where Sage ERP MAS
data is located, the Windows folder, and access to the Registry. This
account must also be granted the Log On as a Service right.

If you are not running in a domain environment, create and use a local
computer account for your workgroup; however, you must ensure this
account can execute a UNC path to the MAS90 folder. Test this by
entering the UNC path in Windows Explorer. If you are prompted for a
user name and password, the account is not set up properly.

4 After a user is created, on the Windows Start menu, select All Programs
> Sage > Application Server Service Setup. A dialog box appears.
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5 Select the path of the Sage ERP MAS installation, if it is different than
the default Sage ERP MAS installation path. The Application Server

Service installation wizard installs the service components necessary to
run the Application Server as a service.

& Note 6 Use the Services applet to configure the service.
Y . . |
v;;r;i(;rﬁg; s may a Right-click the Computer shortcut on the system's Desktop, and then

depending on the
version of Windows

you are using. b In the left pane of the Server Manager window, select Configuration.
The Services item appears in the right pane of the window.

select Manage. The Server Manager window appears.

E== Server Manager

=10l x|

File Acton View Help
L AN el Y
5 Server Hanager (WINOED 10T
i‘ Roles

Features
§ Diagnostics mSk Scheduler
& Configuration &P Windows Firewall with Advanced ...
% Storage / Services
£ WMI Control

&l ocal Users and Groups

1 |

¢ Double-click Services. All of the services available on the server
appear in the right pane of the window.

d Double-click either Sage ERP MAS 200 Service or Sage ERP MAS 200
SQL Service, depending on which product you are using. The
properties window for the service opens.
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There are two settings you may want to change:

® The startup type, by default, is set to Manual. To have the service
start automatically whenever the system is restarted, change the
startup method to Automatic. If the service is set to Manual, you will
need to launch this window to start up the service each time the
server is reset. You may want to set the service to Manual if you plan
on performing maintenance on the server and do not want the
Application Server service to start up after restarting.

x
General | Log On I Heco\reryl Dependencies I
Service name:  Sage ERF MAS 200 SGL 10000

Display name: Sage ERP MAS 200 SQL 10000

Description: ’A{:plicaﬁon Server Service ;I

-]

Path to executable:
ChSage Software'MAS 200 SQL\Version4'MAS30 home'lib_appsenvma

Startup type: Manual j

Help me corfiqure service startup options.

Service status:  Stopped

Start | Stop | Fauze Fesume

You can specify the start parameters that apply when you start the service
from here.

Start parameters: I

QK I Cancel Apply
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¢ Change the logon user to the domain user that was created
previously to run the Sage ERP MAS Application Server. Do not run
the Sage ERP MAS Application Server service under the Local
System account. The Local System account does not have access to
certain network resources that Sage ERP MAS requires. Provide the
user logon and password information where specified.

Sage ERP MAS 200 SQL 10000 Properties (WIN-03 1'

General LogOn | Heco\reryl Dependencies I
Log on as:

" Local System account
I | fllow service o interact with desktop

¢ This account: M\Administrator Browse... |

=
F

Corfirm

Help me configure user account log on options.

You can enable or disable this service for the hardware profiles listed below:

Hardware Profile | Service |
Undocked Profile Enabled
Troubleshooting using hardware profiles. Enable | Disable |

oK | Cancel | Ay |

7 Click Apply to save any changes.

8 On the General tab, click Start to begin the service. The Service Status
message changes to Started, and users can now access Sage ERP MAS.
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Advanced Features

The Application Server has a number of additional features that can be
useful for system administrators. You can enable some of these features for
added security or logging purposes; however, these are not required to run
Sage ERP MAS. To enable these features, you must log on to the server and
start the Application Server Configuration program.

Session Tracking

In the Application Server Configuration window, on the Sessions tab, you
can view a list of all the users who are currently in the system and which
program they are running. This window also provides you with more
detailed information about the machine name, IP address, and connection
time for each process. This is useful when trying to find users on the system
or people in a particular application. Master Console in Sage ERP MAS can
also be used for this purpose.

Individual sessions can also be terminated if they appear to be locked up or
become unresponsive. Terminating a process in this manner can cause data
corruption issues and should only be done as a last resort. To terminate a
session, select the session from the list and then click Terminate.

SSL Encryption

The Application Server can be configured to use SSL to encrypt data being
sent to and from the Application Server. This can be extremely useful when
using the Internet or any other unsecure medium to connect workstations
to the server; however, SSL does add extra overhead in terms of
performance. This feature should be enabled only if it is necessary. Using
SSL in a secured, intranet environment or over an already protected
tunneling protocol (like VPN) is not recommended due to the potential
performance impact.

The SSL component of the Application Server uses the OpenSSL protocol
and drivers. To use SSL, you must first configure the Sage ERP MAS
Application Server to use SSL and then generate an SSL certificate. For
more information, see Generating an SSL Certificate on page 67.
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To configure the ERP Application Server to use SSL

1 Make sure all users are out of Sage ERP MAS. After SSL is enabled, a
different connection string is required for each of the workstations
connecting to the server. Workstations that do not have this additional
information will not be allowed to connect to Sage ERP MAS.

2 Run the Application Server Configuration program.

3 In the Application Server Configuration window, click the Server tab
and select the Encrypt check box. The Certificate field becomes enabled
and allows you to type the path to the SSL certificate.

4 Provide the full path to the certificate relative to the server where Sage
ERP MAS is installed. After the certificate is entered and validated, the
server automatically updates its configuration.

5 On each workstation that will be connecting to Sage ERP MAS, change
the Sage ERP MAS shortcut as follows: in the Target command line, add
-SSL to the end of the parameter list.

If you receive an error trying to connect to the server after configuring SSL,
perform the following:

* Verify that the workstation startup shortcut was modified.

e Verify which startup icon the user used when trying to connect to the
server, and verify that the -SSL argument is in the target command line.
Users may have more than one shortcut connecting them to the server
that need to be modified.

& Note Generating an SSL Certificate

If you are unfamiliar qeygs C L .
with generatinga 10 use the SSL capabilities of the Application Server, create a .pem file that

certificate for contains both the certificate and your private key in X509 format.
securetransactions,

consultanework  For jnformation on generating an SSL certificate, use the Knowledge Base

oo he Sage Online Web site at ft I to search f.

business partner.  O1 the Sage Online Web site at www.sagesoftwareonline.com to search for
the following text: How to generate an SSL certificate.
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Client/Server ODBC Driver

The Sage ERP MAS 200 server installs client/server ODBC driver
components, which allow remote workstations to process Crystal
Reports worktables using server-side ODBC processing. Report
rendering is completed using a locally cached copy of the form or
report and a local Crystal Reports print engine.

Server-Side Configuration

Set up the client/server ODBC driver to run as a client or as a service
before configuring the server.

Running as an Application or Service

Determine whether to run the client/server ODBC driver as an
application or as a service, and perform one of the following;:

¢ To run the client/server ODBC driver as an application, in
Windows Explorer, locate and double-click the pviosrv.exe file in
the following location:

.\MAS90\Home\pviosrv.exe
e To run the client/server ODBC driver as a service, in Windows
Explorer, locate and double-click the CSODBCService.exe file in

the following location:

.\MAS90\Home\Lib\_appserv\CSODBCService.exe
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Configuring the Server

If you set up the client/server ODBC driver to run as a service, follow the
procedure below to configure the server.

To configure the Server

1 From the Sage ERP MAS 200 server, right-click My Computer on the
system's Desktop, and then select Manage.

e If you are using Windows Server 2008, the Server Manager window
appears.

e If you are using Windows Server 2003, the Computer Management
window appears.

2 Perform one of the following, depending on your version of Windows
Server:

¢ If you are using Windows Server 2008, in the left pane of the Server
Manager window, select Configuration. The Services item appears in
the right pane of the window.

¢ If you are using Windows Server 2003, in the left pane of the
Computer Management window, select Services and Applications.
The Services item appears in the right pane of the window.

3 Double-click the Services item. All of the services available on the server
appear in the right pane of the window.

4 Double-click the ProvideX IO Service item. The ProvideX IO Service
Properties window appears.
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5 At the Startup type field, select Automatic, and then click the Log On
tab.

Providex I0 Service Properties (Local Computer)

Gereral | Log On || Recovery | Dependencies

Service name:  PYXIDSWR

Display name: Providex [0 Service

Description:

Path to executable:
“e:hprogram fileshsage software\mas 200%wersiondsmas30shomesprsiosyr,

Startup tupe: Automatic w

Semvice status; Stopped

“f'ou can specify the start parameters that apply when you start the service
fram here.

Start parameters: ‘ ‘

[ Ok ][ Cancel ][ Apply ]
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6 Verify that the local system is not used.
a Select This account.

b Enter the domain account. This is the domain account that can
execute the path to the MAS90 folder.

Providex |0 Service Properties (Local Computer) E|rg|

Ganaral‘ Log On |Hacuvaw Dependsnciss

Log on as:

() Local System accaunt

(& This account: |Domaim Administrator ‘ [ Browse...

Password:

You can enable or disable this service for the hardware profiles listed below:

Hardware Prafile Service
Prafile 1 Enabled
I QK. ] [ Cancel ] [ Apply l

7 Click the General tab, and then click Apply.
8 Click Start and verify that the service starts successfully.

9 Click OK.
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Workstation Configuration

Use the Library Master System Configuration task to configure the
workstation and then test the ODBC data source.

To configure the workstation

1 On the Sage ERP MAS 200 Desktop, select Library Master Setup menu >
System Configuration. The System Configuration window appears.

2 Click the ODBC tab, and then select the Enable C/S ODBC Driver check
box.

3 At the ODBC Server Name field, enter the server name or IP address
where the client/server ODBC application or service is running.

4 At the ODBC Server Port field, enter an accessible server port or leave
the field blank to use the default port, 20222.

5 Select the Enable for All Users check box on the User Maintenance
Preferences tab only if all users (both LAN and remote) will be using the
client/server ODBC driver.

6 Close and restart the workstation client.
7 Access and test the ODBC data source.
¢ If running a 32-bit system, perform the following steps:
a Select Windows Start menu > Control Panel.
b Double-click the Administrative Tools item.

¢ Double-click Data Sources (ODBC). The ODBC Data Source
Administrator window appears.
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d On the User DSN tab, double-click the SOTAMAS90 item.

#71 ODBC Data Source Administrator

User DSM l System DSN | File DSM | Drivers | Tracing | Connection Poaling | About |

User Data Sources:

HName | Dirivver | Add
SOTAMASI0 MAS 30 4.0 ODBC Driver
Bemaove
LConfigure...

An DDBC User data source stores information about how bo connect o
the indicated data provider. & User data source is only wisible to you,
and can only be uged an the curent machine.

é NoTE

If you encounter
problems oKk | Cancel | | Help |
connecting to the

client/server ODBC

e The ProvideX ODBC Driver Setup window appears. Click the

service, see ] ;

Configuring the Debug tab, and then click Test Connection.

Workstation for the

ODBC Driver Service If a message appears stating that the connection was successful,
on page 142.

the client/server ODBC service is running correctly.
¢ If running on a 64-bit system, perform the following steps:
a On the Windows desktop, double-click the Computer icon.

b In the Computer window, locate the c:\windows\SysWOW64
folder.

¢ Double-click Odbcad32.exe. The ODBC Data Source
Administrator window appears.

d On the User DSN tab, double-click the SOTAMAS90 item.

e The ProvideX ODBC Driver Setup window appears. Click the
Debug tab, and then click Test Connection.

If a message appears stating that the connection was successful,
the client/server ODBC service is running correctly.
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Sharing Permissions

On the Sage ERP MAS 200 server, you can set the share permissions to
V allow users to print server reports. You can grant permissions at the share
NoTE . o
For more point to allow for Read, Change, or Full Control access. When printing a
information about ~ version 4.x form or report, the user can print to any valid Windows printer,

setting permissions, - defer reports, or export or e-mail.
see Sage ERP MAS

Security Permissions

Users with no access to the Sage ERP MAS 200 share point on the server
on page 145.

will be able to print to Deferred. To print or preview from Deferred
Printing, users must have a minimum of Read access to the Sage ERP
MAS 200 server share point.
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Installing Crystal Reports Designer

Crystal Reports Designer is a powerful, graphics-oriented reporting
program that allows users to customize their graphical forms. Crystal
Reports Designer is fully integrated with Sage ERP MAS. Sage ERP
MAS provides a number of customizable Crystal Reports forms as
part of the standard installation.

The Workstation Setup program for Sage ERP MAS installs the
standard Crystal Reports Run-Time Engine on each workstation,
which allows all users to view and print reports created through
Crystal Reports; however, to modify the standard forms included
with Sage ERP MAS, or to create your own reports, you must install
the Crystal Reports Designer.

Crystal Reports Designer will run with the Sage ERP MAS ODBC
driver as well as the standard Microsoft SQL Server ODBC driver.

If you are using Sage ERP MAS 200 SQL, you will need read access to
the applicable database. For information, see Modifying Crystal
Reports in Sage ERP MAS 200 SQL on page 78.

Installing Crystal Reports Designer to the Workstation

To modify or create Crystal Reports forms and reports, install Crystal
Reports Designer to the workstation and select the Typical
installation option, which uses pre-assigned settings.

To install Crystal Reports Designer to the workstation
1 Place the Sage ERP MAS product DVD in the DVD drive.

2 If Autorun is enabled on the workstation, the Autorun screen
appears; otherwise, on the Windows Start menu, select Run, and
type D:\Autorun.exe, where D:\ is the DVD drive. Select a
product, and then on the product screen, click Productivity
Applications.

3 On the Productivity Applications screen, click Install Crystal
Reports Designer.
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Vi 4 The Crystal Reports XI Release 2 for Sage Setup page appears. Follow
Selec’t\ltggiypical the steps in the installation wizard to install Crystal Reports Designer. A
installation type. progress meter appears while the installation is in progress.

Modifying Crystal Reports in Sage ERP MAS 200 SQL

To modify reports in Sage ERP MAS 200 SQL using Crystal Reports
Designer, you must either be logged on using a Windows account that has
read access to the applicable SQL Server database, or you must have a
separate SQL Server authenticated logon ID and password. Integrated
Security is used by default; if your Windows account does not have rights
to the database, a logon dialog box appears, allowing you to enter a
different logon ID and password for database access.

Set up an OLE DB (ADO) Connection

In addition to using Crystal Reports Designer to modify reports, you can
also modify the reports through the operating system by setting up an OLE
DB (ADO) connection to the SQL Server database. Only modifications such
as moving items around on the report, changing font information, and
hiding or showing information already in the data base is supported.

To set up an OLE DB (ADO) connection

1 In Windows Explorer, browse to the .rpt file to modify in the
MAS90\Reports folder, and open the file.

2 Select Database menu > Database Expert.
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3 Expand Create New Connection and then expand OLE DB (ADO). This

opens the OLE DB (ADO) window.

A Database Expert le

Data |

Browse the data source for the tables you want to add.

{Mote: to edit the alias for a table, select the table in the "Selected Tables'tree and click on it or
press the F2 key)

Available Data Sources: Selected Tables:

[ Favorites = & SOTAMASSD

[Z History AP_AnalysisReport Wi

g
[ Access/Excel (DAQ)
@AcT!
[ZAADO.NET (ML)
[Z1COM Connectivity
[Z Database Files &
[ Exchange 5.5 Message Tracking | .
[Z Exchange Message Tracking Log
[ZField Definitions Only
[ZFile System Data b
(ZLegacy Exchange
(ZMailbax Admin
[ZAMS 115/Prowy Log Files
[ZIINT Archived Event Log
[ZINT Curert Event Log
[ZA0DEC (RDO)
[ZAOLE DE (ADO)

>

|€

S
|»

ok || cancel ][ Hebp
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80

4 From the Provider list, select Microsoft OLE DB Provider for SQL Server

and click Next.

OLE DE (ADO}

OLE DB Provider

Frovider:

Use Data Link File:

Select a provider from the list or select a data link file.

Microzoft OLE DB Provider for Indexing Sers A
Microsoft OLE DB Provider for Internet Publi: —
Microsoft OLE DB Provider for ODBC Drivers
Microsoft OLE DB Provider for OLAP Service
Microsoft OLE DB Provider for Oracle

! OLE DE P! e fio
Microzoft OLE DE Simple Provider B
MSDataShape

M1l F R Pressider fer Microsnft Dirsetam Gan, 0
<

O

Mest »

] [ Finizh ] [ Cancel ] [ Help

X]
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5 Type the server name where the database is installed, select the
database, and select the Integrated Security check box.

OLE DB (ADO) 53
Connection Information
Provide necessary information to log on to the chosen data source.
Server: v
User ID:
Password:
Database: v
Integrated Security: [F
[ < Back ][ Mext > ] [ Finish ] [ Cancel ] [ Help ]

6 Click Finish and then, at the Database Expert window;, click OK.

7 Save the report. The report is now linked to the SQL Server database.
Any dictionary changes that have been made to the table are now
available in Crystal Reports Designer.

Converting Crystal Reports from a Prior Version

When upgrading from a prior version of Sage ERP MAS, any custom
& NOTE Crystal reports and forms must be converted to run in version 4.50.

For information on

converting reports Converﬁng Reporfs

for that product, see

Converting Reports The MAS Crystal Report Conversion Wizard converts prior versions of
for Sage ERP

MAS 200 SQLon  Sage ERP MAS 90 and 200 Crystal Reports forms and reports to the latest
page 86. data dictionary revisions and Crystal Reports format.
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To convert reports

1 In the MAS90\Home folder, locate and double-click mascrcw.exe. The
MAS Crystal Report Conversion Wizard appears. Click Next.

Vi 2 Inthe Choose a Data Source page, click Configure to open the ProvideX
NOTE ODBC Driver Setup window.

This wizard runs the
first time you 3
access a Crystal
Report created

using a level of FA ProvideX ODBC Driver Setup 2x
Sage ERP MAS
prior to version
4.50.

At the Database Directory field, verify that the path is correct.

Basic |Server Logon || Options | Debug | About

Data Source Name: ‘ |

Descriptior: | MAS 90 4.0 ODEC Driver |

D atabase Directory: ‘ ATyphoon'MAS 2000300 MAS S0 |
[This directory should contain PROVIDEX.DDF)

Definition Eile; ‘

(Path af IMI file for nan-dictionary defined fileg]
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4 Click the Logon tab. At the Company code field, type your company
code in uppercase. Verify that the company selected has the appropriate
modules installed. For example, do not convert Manufacturing Crystal
reports (W/O or B/M) for demo company code ABC. Those modules
do not exist in company ABC, and the conversion will not complete on
the reports.

At the Default UserlID field, type the user logon and type the password
at the Password field. Click OK.

FH ProvideX ODBC Driver Setup EX

Basic Servell Logon |Dpliuns Debug | About

Company code: |N3C |

Default UserlD: |JCN |

Password: | mim |

Seszion D: | |

[ oK ]I Cancel ]I Lpplp ]

5 Inthe Choose a Data Source page, type the same user logon and
password that you typed in the ProvideX ODBC Driver Setup window.
Click Next.

MAS Crystal Report Conversion Wizard ﬁlr‘s_(l

Choose a Data Source

The Conversion Wizard needs access to a valid data source in order to
wveriFy the changes made ta each repart.

Data Source ‘Prowdex (SOTAMASIO) j Configure

User ID JCH
Password asssnes

< Back Mext = Cancel
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6 At the Reports Path field, enter the path, or click Browse and select the
folder to search for reports that require conversion. All forms and
reports that have been previously converted and those that contain the
current Sage ERP MAS version as a keyword will not be selected for
conversion.

7 Click Search to generate a list of reports. Click Cancel to stop the search.
You can select individual or multiple reports within the listing to
convert. Select the report, or press CTRL to make multiple selections.
Click Select All to convert all reports within the listing. Click Clear to
clear the listing. To complete the conversion, click Next.

MAS Crystal Report Conversion Wizard E|

Select Reports

Specify the directory you wish to locate reparts in and click Search. Then
select the reports that you wish to corvert,

Reparts Path CHiProgram FilesiSage SoftwarelMAS 90lYersion4iMasa0
Report Report Path -

[] aPwon1.RPT  C:iProgram Files\Sage SoftwareiMAS 90iWersiond) m
[] aPwooz RPT  C:\Program Files\Sage Software\Mas 90iWersiond)
[ apwions RPT - CiiProgram Files\age SoftwareiMas s0iversiond)
[] aPwoo4.RPT  CriProgram Files\Sage SoftwareifMas 90iWersiond)
[] aPwFBALRPT C:i\Program Files\Sage SoftwareiMaS 90iWersiond)

[] aPwFEAZ.RPT C:\Program Files\Sage Software\Mas 90iWersiond)
[] apwibaz.rpt  CiiProgram Files\age SoftwareiMas siversiond) v

< >

8 Inthe Completing the MAS Crystal Report Conversion Wizard page,
perform one of the following;:

¢ Click Finish to initiate the conversion process.
® Click Back to return to the previous wizard or page.

e (Click Cancel to exit the wizard.
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9 If you clicked Finish, the Converting Reports window appears. Click
Print to get a listing of the selected reports and the conversion status of
each report. The listing prints to the default Windows printer.

If a field name used within the report or form no longer exists in the data
source, it will be noted on the listing and removed from the report or form.
If the removed field is contained in a formula, a Crystal Reports error in
printing message will appear when printing.

Successfully converted reports generate an unconverted backup file in the
same folder with a file extension of .rp_. If Status:Complete appears, the
report is successfully converted. If Status:Failed appears, note the error
message and verify that the company you are logged onto using ODBC
contains application data files for the selected report. If the conversion
wizard cannot convert that report, the report must be manually converted.
If errors are encountered during the conversion, the wizard will skip the
report and continue with the next selected report.
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Converting Reports for Sage ERP MAS 200 SQL

Follow the steps below to convert customized Crystal forms and reports

from a prior version for Sage ERP MAS 200 SQL.

1 Inthe form or report printing window, click the drop-down arrow in the

top-right corner, and then click Designer.

[ Customer Sales Analysis (ABC) 5/31/2010

ReportSeing | STANDARD Q [ save [-]
Description Customer Sales Analyzis Save
Setting Options Save As
Type Frint Report Settings I:‘ Mumber of Copies Qe'?te
Default Report Three Hole Punch I:‘ Destaner
Sort Report By | Customer Mumnber v
Options
Fizzal Year 2010w
Accounting Period 0 6/30/2010  »
[ata to Print
Period to Diate Data
“rear to Date Data
Frior rear Data
Selections
Select Field Operand Walue -
Customer Mumber All @
Customer Mame All @
Salezperzon All -
Customer Type All - v
Keep Window Open After - -
Laser Printer *| Print I:‘ Preview I:‘ [ LR I HIE) I =0 @

2 In the Crystal Reports Designer window, on the File menu, select

Summary Info.

86

Installation and System Administrator's Guide




CONVERTING CRYSTAL REPORTS FROM A PRIOR VERSION

3 In the Document Properties window, in the Keywords field, replace the
version that appears with 4.50, and then click OK.

Document Properties r$_<|

Summary | Statistics

Application: Crystal Reports

Authar: | Sage |

Kepwords: |E0nverted to wergion 4.50 |

Comments:

Title: | Customer Sales Analyzis |

Subject: | |

Template: | |

[] 5ave Preview Picture

[ QK ][ Cancel ][ Help ]

4  On the Database menu, select Verify Database. The OLE DB (ADO)
window appears.
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5 Perform one of the following:

¢ If your Windows logon account has Read access to the database, click
Finish.

¢ If your Windows logon account does not have Read access to the
database, clear the Integrated Security check box, enter a user ID with
access to the database and its password, and then click Finish.

OLE DB (ADO) 53
Connection Information
Provide necessary information to log on to the chozen data source.

Server: |Application Server w |

Uszer ID: | |
Pazsword: | |
Database: |Mas_aBC v|
Integrated Security: [F

[ < Back ][ Mext » ] [ Finizh ] [ Cancel ] [ Help ]

If it is necessary to remap any fields, follow the instructions in the Crystal
Reports Designer Help system. Complete these steps for all forms and
reports that were customized in the previous version.
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Chapfter

Installing Federal and State eFiling and
Reporting

Federal and State eFiling and Reporting Overview

Vi Federal and State eFiling and Reporting software allows you to print

b NOTE and electronically file your payroll tax forms and 1099 forms using
ayroll features in | . . c.

Federal and State  Signature-ready plain paper tax forms. Every report is saved in its

eFiling and own history or draft file for easy retrieval.
Reporting are
available only in

sage ERP MAs 90 Considerations for Installing Federal and State eFiling
and 200. and Reporting

* To use Federal and State eFiling and Reporting with data created
in Sage ERP MAS version 4.20 or prior or from another business
management system, perform the upgrade to version 4.50 after
the quarter end and before the first payroll in the current quarter
to avoid values being placed in the wrong boxes on some forms. If
conversion is performed mid-quarter, some eFiling and Reporting
forms will require editing.

¢ If you are upgrading from version 4.20 or prior, and a tax limit
type other than Annual is selected in Payroll Tax Table
Maintenance, your limit values will not be calculated correctly on
eFiling and Reporting forms until the first payroll run after
upgrading to version 4.50.
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Installing Federal and State eFiling and Reporting to the
Workstation

You must install Federal and State eFiling and Reporting separately on each
Sage ERP MAS workstation. Do not install the module on the server.

To install Federal and State eFiling and Reporting to the workstation
1 Log on to the workstation as a user with Administrator rights.

2 Place the Sage ERP MAS product DVD in the DVD drive. If Autorun is
enabled on the workstation, the Autorun screen appears; otherwise,
select Windows Start menu > Run and type D:\ Autorun.exe where D:\
is the DVD drive.

3 Select your Sage ERP Product, and then click Productivity Applications
on the product’s main screen.

4  On the Productivity Applications screen, click Install Federal and State
eFiling and Reporting.

* To begin the installation process from a server installation of Sage
ERP MAS 90, map a drive letter to the share point above the MAS90
folder. In the MAS90\Wksetup folder, double-click Autorun.exe, and
then click Install Federal and State eFiling and Reporting on the
Autorun screen.

¢ To begin the installation process from a server installation of Sage
ERP MAS 200 or 200 SQL, use Windows Explorer to attach to the
server share point where Sage ERP MAS is installed. In the
MAS90\Wksetup folder, double-click Autorun.exe, and then click
Install Federal and State eFiling and Reporting on the Autorun
screen.

5 The installation wizard for Federal and State eFiling and Reporting
appears. Proceed through the steps in the wizard to complete the
installation.

6 Click Accept to accept the terms of the license agreement. You must
accept the agreement to continue with the installation. A progress meter
appears while the installation is in progress.
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Share and NT File System (NTFS) Permissions

For Sage ERP MAS 200 and 200 SQL, on the server where Sage ERP MAS is
installed, you must set the share permissions to Change. For users that will
generate eFiling forms and reports, set the Write permissions to the
following folders (where XXX is the company code):

& Nore .AMAS_XXX\APXXX\eFilingReporting

For more
information about

setting permissions, -+ \MAS_XXX\PRXXX\eFilingReporting
see Sage ERP MAS
Security Permissions  The share permissions and folder NTFS permission must be set up before

on page 145. users can use Federal and State eFiling and Reporting.
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Setting Up Credit Card Processing

Use the Credit Card Processing module powered by either Sage
Payment Solutions or PCCharge Payment Server for validation and
authorization of credit cards through modules such as Accounts
Receivable, Sales Order, and eBusiness Manager. Both Sage Payment
Solutions and PCCharge Payment Server work with a number of
popular merchant accounts.

Sage Payment Solutions

The Credit Card Processing module powered by Sage Payment
Solutions is installed with Sage ERP MAS and requires the Accounts
Receivable and Sales Order modules to be installed. For more
information, see Set Up the Credit Card Processing Module for Sage
Payment Solutions in the Help system.

PCCharge Payment Server

The Credit Card Processing module powered by PCCharge Payment
Server is installed with Sage ERP MAS and requires the PCCharge
Payment Server and the Accounts Receivable and Sales Order
modules to be installed.
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Installing the PCCharge Payment Server

Installation of the PCCharge Payment Server is a multi-phase process.

To install the PCCharge Payment Server

1 Make sure you have all the information required to configure your
PCCharge Payment Server before running the installation. Follow the
instructions included in the PCCharge Payment Server online
documentation.

2 Review the PCCharge Payment Server manual available on the PCCharge
Payment Server CD. The manual is provided as a PDF file.

& Nore 3 Install the PCCharge Payment Server. Select a server on your network
ZC%SJUTECSZ?JZEH that has a modem connection or access to the Internet. You will need to
modem determine your hardware requirements based on which merchant you
connections, but are using.

only a few support

SSLthroughthe 4 Contact VeriFone Technical Support to activate your PCCharge

Internet. o e . . . .
Payment Server software (this information is also included in the
PCCharge Payment Server online documentation).

5 Sage ERP MAS communicates with the PCCharge Payment Server
using TCP/IP, which is not the default configuration. If TCP/IP is not
configured, perform the steps below to enable TCP/IP support and
establish a port on which the PCCharge Payment Server will be
listening. If TCP/IP is configured, proceed to step 6.

a Start the PCCharge Payment Server and select Setup menu >
Preferences. In the Preferences window, click Advanced.

b In the Advanced Configuration Setup window, select the Use
TCP/IP Connection check box in the TCP/IP Communications area.

The Local Port Number defaults to 31419. You can change this to any
port number that is not currently in use on this workstation by
another application. Do no use ports under 1024. These ports are
reserved for common services (such as HTTP, SSL, and SMTP).
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Consult your system administrator to verify there are no port conflicts
occurring on the machine to which you are installing the PCCharge
Payment Server. Write down the port number if you change it so that it
can be recorded in Sage ERP MAS.

6 Configure the Sage ERP MAS component so the applications can
communicate with the PCCharge Payment Server.

7 The PCCharge Payment Server is not accessible from within Sage
ERP MAS until the Credit Card Processing module is registered. To
Vi enable the Credit Card Processing module for PCCharge Payment
NoTE

: Server, perform the following:
If the Credit Card
Processing module
is not registered,
the fields on the
Servers tab are not b Click the Servers tab. At the Enable Credit Card Payment Server

available. field, select PCCharge.

a Select Library Master Main menu > Company Maintenance.

¢ Enter information in the remaining fields.

[ Company Maintenance (ABC) 5731 /2010

Company Mame | 4BC Distribution and Service Carp.

1 Main | 2 Preforences | 3 Servers ] 4Emal | BFa |

Credit Card Payment Server
Enable Credit Card Payment Server PCChargs ~

IP &ddress Port

Path =
Timeout S

Enable Batch Authorizations (]

Fores Reconnect for Each Autharization (]

Credit Card Processing Debug

Activate Debuaging Log O Activate Debugging Display (]

Clignt S erver

‘web Reports Server Name
“web Reports Virtual Directary

Accept [ Cancel [ Delete
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Accessing the Payment Server Manual

The PCCharge Payment Server manual is available on the PCCharge Payment
Server CD as a PDF file. If you do not have Adobe Acrobat Reader installed
on your workstation, you will need to install it before accessing the
documentation.

To view the PCCharge Payment Server manual, open Windows Explorer,
browse to the CD drive where the PCCharge Payment Server CD is located,
and double-click the DOCUMENTATION.PDF file.

Support and Upgrades

VeriFone provides support for the PCCharge Payment Server product and
can assist you with troubleshooting the setup, configuration, and
continuing maintenance of the server. Contact VeriFone if you are having
problems receiving authorizations. For contact information, refer to the
PCCharge Payment Server online documentation.
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Performing System Startup

After installing Sage ERP MAS, you are ready to set up companies,
security, and system preferences. One company must be created in
Sage ERP MAS before anyone can access the system.

During the installation, a program group is added to the Windows
Start > All Programs menu. Click the Sage ERP MAS Desktop icon in
this program group to start the software.

Starting the Software

When first starting Sage ERP MAS, you are prompted to enter the
Administrator password that you entered during the installation.

(s Sage ERP MAS 200 User Logon

g:] Enter your uger logon name and password.

User Logon |Adminislralul |
|

Pagzsword |

After entering your Administrator password, the Administrative
Tools screen appears.

Logging on as Administrator does not give you full access to the
software. Only certain Library Master tasks are available. To access
the software, you must set up a user logon (other than the
Administrator logon) and password in User Maintenance. For more
information, see Setting Up Security on page 104.
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Performing Administrative Tasks
You can perform the following tasks from the Administrative Tools screen:

¢ Create and activate companies for new installations (see Creating and
Activating Companies on this page)

& Note * Define user roles, create users, and assign roles to users (see Setting Up
You must create Roles and Users for Security on page 104)

and activate

companies and * Set up system preferences (see Setting System Preferences on page 117)
then create user

roles before °

Change your administrator password (see Changing Your

ti .
creating users Administrator Password on page 126)

e Change the key phrase seed value for credit card key encryption key
generation.

* Change your participation in the Sage Product Enhancement Program.

Creating and Activating Companies

You must create and activate the companies for which data will be
processed. Many systems are set up with multiple companies to keep
financial records for individual companies separate, and to separate real
company data from test company data. Each company is identified using a
three-character company code. Within the modules, you can set up data
files for each company.

If you are creating companies that contain similar information, you can
create companies from an existing company by copying information from
the source company. For more information, see Copying a Company on
page 102.

To create and activate a company

1 Use any of the following methods to open the Company Maintenance
window:

¢ In the Administrative Tools screen, click Company Maintenance.

* Select Library Master Main menu > Company Maintenance.
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2 In the Company Maintenance window, enter a company code and
company name.

3 Enter the fields appropriate to your company, including the Federal ID
No. field.

[is Company Maintenance (ABC) 5/31/2010 E@

Company Code 4 4 b ki Activate... | | Convert...
Company MName |ABE Distribution and Service Com |
Py

1. Main ] 2 Preferencas] 3 Servers ] 4 E-mail ] 5. Fax ]

Company |nfarmation

Address Telephone [
Fax [1]
Federal D Mo
State |0 N

URL Address @

E-mail Address (=i

Trade Name

Activated Modules

Module DataLevel

I Accept ] Cancel ] LDelete

4 Click Activate to activate one or more modules. Click Yes, when you are
prompted to save the new company.
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5 In the Activate Module window, select the module(s) to activate and
click Proceed. This process creates data files for each selected module
for the company.

(5 Activate Module E] @ @

ABC Distribution and Service Corp. [ABC]

Madule Achivate 2 @

@

Comman Information

ogd

Business Insights
General Ledger
Accounts Receivable
Accounts Payable
Payroll

Inventory Management
Sales Order

ooooooo

Purchase Order ~

Proceed LCancel m
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6 The Company Maintenance window appears again after the activation
process is complete. Verify that the modules you selected appear in the
Activated Modules section of the window.

The demo data company codes are automatically created and activated

if they were selected during the installation process.

(i Company Maintenance [ABC) 5/31/2010

Company Code 14 4 b Pkl ert
Company Hame |ABC Distribution and Service Corp, ‘
P
1Man | 2 Pefeences| 3 Semers | AEmal | SFa |
Company |nformation
Addiess 6561 livine Center Drive Telephone (949 5551212
Irvine, CA 92618 Fax 1843) 555113

Federal ID Mo, | 95-123456783012

State |0 Mo
URL Address @
E-mail Address (=
Trade Name
Activated Modules
hodule: Data Level
Accounts Payable 450
Accounts Receivable 450
Bank Reconciliation 450
Commen Information 450
General Ledger 450
Inventony b anagement 450
e-Buginess Manager 450
Purchase Order 450
Fayroll 450
Retumn Merchandize Authorization 450
Sales Oider 450

[ Accept 1 LCancel 1 Delete m
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Copying a Company

You can create a new company from an existing company. You can copy
information, including company data and company forms, from the source
company.

To copy a company

1 Use any of the following methods to open the Company Maintenance
window:

¢ In the Administrative Tools window, click Company Maintenance.
¢ Select Library Master Main menu > Company Maintenance.

& Note 2 In the Company Maintenance window, enter a company code and

Although you can company name.
define multiple

company codes, :
you must define at [ Company Maintenance (ABC) 5/31/2010 Q@@

least one company Compary Code ,—| 4 b+ # Activate... || Corwert...
code before Company Name |ABC Distribution and Service Corp. |
activating any
modules. 1. Main ] 2 F’refalences] 3. Servers ] 4 E-mail ] B Fax l
Company Infarmation
Address Telephane [
Fax [
Federal ID Na.
State ID Mo
URL Address @
E-mail Address A
Trade Name

Activated Modules

Madule Data Level

[ Accept I Cancel I Delete
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3 Click Copy.

4 In the Copy Data window, at the Source Company field, enter the
company you are copying from.

[ Copy Data E]E|

Source Company ABC Q ABC Distribution and Service Corp.
Destination Comparny | JBC John's Company Data
Options
Modules Data | Forms
1 (0] Common Information M N @
2 E/S Business Insights M N
3 |G General Ledger M N
4 AR Accounts Receivable M N
5 CiU Customer Aelationship Managem [ N&
6 |apP Accounts Payabls M N
7 148 Inventory Management M N
8 |5/0 Sales Order M N
3 |P/O Purchase Order M N
10 | R/a Aetum Merchandise Authonization  [W N&
11 | B/R Bank Reconcilistion M N
12 | FL Fired Assets M N
(ot [ e @)

5 To copy data and/or forms, select the corresponding check boxes.

6 Click Proceed.

Migrating and Converting Data

If you are migrating data from a previous installation, refer to your
Customer Upgrade Guide for migration instructions. If you performed an
in-place installation, refer to your Customer Upgrade Guide for information
on converting your data to version 4.50.
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Setting Up Security

Sage ERP MAS offers a flexible security system that can be used to provide
appropriate access to the system and to meet your company's specific
requirements. The security system can be simple, or it can be elaborate,
protecting various combinations of companies, modules, menus, tasks, and
security permissions by creating multiple roles, and assigning these roles to
users. Roles are assigned to users so that users are restricted to only those
tasks that pertain to the roles they are assigned to. If the user attempts to
access a secured area, access is denied.

Setting Up Roles and Users for Security

To implement effective security, you must define roles for your system, and
then create user codes and assign users to specific roles.

The security for Sage ERP MAS is role-based. Roles should be set up to
reflect the functional roles of your organization. You should define roles
with access to certain modules, tasks, and security events that allow users
to perform tasks related to their jobs. Roles are company independent,
though you can assign roles to users who are restricted from entering
certain companies.

A Default role is included in Sage ERP MAS. Users assigned to the Default
role have access to all modules except security events. The Default role
cannot be modified in Role Maintenance.

When establishing your system's security, use the concept of roles to
identify the specific tasks and options you want users to be able to access.
Users can be assigned to multiple roles so design your roles to be as
granular as you like. Role permissions are cumulative, which means if a
user is assigned to two roles where one role gives the user access to a
program while another role does not, the user will be granted access to this
program.

You must determine the requirements for your security system. In most
cases, it is better to start with a simple arrangement. As more sophistication
is needed, this flexible system can be easily refined.
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Defining Roles

& Nore | Roles are set up to reflect the functional roles within an organization. These
To access Role roles are global to the software and are company independent. Permissions
Maintenance, you - )

must be logged on ~ @ssigned to roles allow assigned users access to the areas of the software

as Administrator, or - they need to perform their job functions.
have a role

assignedtoyouthat  For the General Ledger, Library Master, Accounts Payable, Accounts

allows access to . Tsge . . . .

Role Maintenance.  Receivable, Bank Reconciliation, Business Insights, Customizer, eBusiness
Manager, Return Merchandise Authorization, and Sales Order modules,
security can be further refined by assigning Create, Modify, Remove, or
View permissions to maintenance tasks, or by setting Update or Print Only
permissions to update tasks. For setup tasks, permissions can be set to
Modify or View. Additionally, some module options, such as allowing
batches to be merged can be allowed or restricted.

Defining roles is considered the first step in enabling security for your
system. Before you define roles in your system, determine the functional
roles needed for your organization.

To define roles

& Noe 1 Use any of the following methods to open the Role Maintenance
Library Master window:
tasks are not ’

company-specific. L. . X .
¢ In the Administrative Tools screen, click Role Maintenance.

e Select Library Master Main menu > Role Maintenance.

2 In the Role Maintenance window, at the Role field, type the name of the
role (for example, AP Clerk).

Installation and System Administrator's Guide 105



Chapter 12 Performing System Startup

3 At the Description field, type a description for the role (for example,
Accounts Payable Clerk).

[k Role Maintenance | ) 5/31/2010

|

Description |Ac:0unls Payable Clerk

1. Tasks ] 2. Security Events ] 3. Module Dptions 1 4 0DBC Security ]

[ MAS 80

[ Accounts Payable I
Accounts Recelvable

[ Bank Reconciliation

[ Bill of Material:

[ Business Insights

[ Comman Infarmation

[ Custarn Difice

[ Custamer Relationship Management
[ Fixed Agsets

General Ledger

Inventory Management

[ Library Master

=

~

[ Accept [ LCancel [ Delete l

4 If you are creating a role from an existing role, click Copy Role;
otherwise, skip to step 7.

5 In the Copy Role window, enter the name and description of the new
role to create.

5 Copy Role

Copy Fram

MNew Role Name

Description

Optici
Copy Menu Tasks
Copy Secuiity Events
Copy Module Dptions

Lancel m

6 Select the check boxes for copying menu tasks, security events, and
module options permissions, then click Proceed.
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& NOTE

To allow access to
all modules and all
security
permissions, for the
role, select the
MAS 90 check box.

SETTING UP SECURITY

7 On the Tasks tab, you can restrict access to modules, tasks, or security
permissions within tasks.

* To expand each level, click the + graphic. To select all items in a level,
select the check box next to the option.

¢ To refine the level of security to individual modules and tasks, select
the check box next to the individual modules that you want to allow

access to.

® You can further allow or restrict the level of access to tasks within a
module by selecting or clearing the check boxes for tasks within

modules.

[ Role Maintenance { ) 5/31/2010

Description |Ac:nunts Payable Clerk |

1. Tasks ] 2. Securty Events ] 3. Module Optiohs 1 4 ODBC Security ]

= [ Accounts Payable
[ Explorer Yiew

[ Inguiry

[ Maintenance/Data Enty

[ Miscellaneous Tasks

[ Reports/Farms

[ Setup Options

[ Update/Period End

[ Accounts Receivable

[ Bank Reconciliation

[ Bill of Materials

[ Buziness Ingights o

[ Accept [ LCancel [ Delete l
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108

8 On the Security Events tab, select the check boxes next to the module
and security events that you want to assign to the role. For more
information, see Role Maintenance in the Help system.

5 Role Maintenance { ) 5/31/2010 FEx
werm

Description | &ccounts Payable Clerk

1. Tasks ] 2. Secuiity Events ] 2. Module Optiohs l 4. ODEC Security ]

unts Papable
[ Allow Access to Private Batches
[ Allows Editing of History Data inYendor Maintenance
[ Allows Editing of Statistic Data in VYendar Maintenance
1 Allowe Purging of Yendar Audit
[ Allow Updating of Journals from Preview
[ Allows User Access to Remaove Yoided Checks

[ Accounts Receivable

[ Bank Reconcilistion

[ Bill af Materials

[ Business Insights

[ Common Information

BB R B

"

[ Accept [ LCancel [ Delete l @

9 On the Module Options tab, select the check boxes next to the options to
which you are allowing access.

10 Click Accept and repeat this procedure for each role you want to define.
After defining all roles for the system, you can create users, and then assign

these roles to users. For more information, see Creating Users and
Assigning Roles on page 109.
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Creating Users and Assigning Roles

Defining a user includes setting up a logon and password, assigning access
to specific companies, and assigning a role or multiple roles to the user.

A user account can be defined with an expiration date to lock the user out
of the system after a certain amount of time. You can also define start and
end dates for any role assigned to the user. This feature allows a user access
to certain areas of the system and security events for the limited period of
time.

Before you create user logons and passwords, decide whether your system
will require a unified logon or a Sage ERP MAS logon for all users. For
more information, see Requiring a Password on page 117.

& Nore To create a user and assign a role
You can access

User Maintenance 1

only if you are Use any of the following methods to open the User Maintenance

logged on as window:
Administrator, or if
you have a role ¢ In the Administrative Tools screen, click User Maintenance.

assigned to you that
allows access to

; ¢ Select Library Master Main menu > User Maintenance.
User Maintenance.

Installation and System Administrator's Guide 109



Chapter 12 Performing System Startup

2 In the User Maintenance window, enter the User Logon field. If you
selected the Use Unified Logon check box in the System Configuration
window, this field must match the Windows logon name for the user.
For more information, see Requiring a Password on page 117.

[ User Maintenance { ) 5/31/2010

User Logon 14 4 & B
First Name | John Last Name | Smith User Code | J'wS
Password Confirm Pagsword Customization Group Expires Z
1. Maintenance ] 2. Preferences ]
Company Role Start Date Expiration Date
a ’
[[] User Account Locked [ Accept l Cancel l Delete ]

3 Enter the First Name, Last Name, and User Code fields. The user code is
only referenced in the software and is not used for logon purposes.

4 If the selected user will be performing group customizations in the
Customizer module, enter the Customization Group field.

5 Enter the Expires field to lock the user account after a certain date. A
user will not be able to access the system after the date entered.

6 If you selected the Require all Users to Enter a Password check box in
the System Configuration window, enter the Password and Confirm
Password fields. If you do not enter a password, when logging on to the
software, the user will be prompted to enter a password. For more
information, see Requiring a Password on page 117.
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7 Select the company and role to assign to the user. You can assign
multiple companies and roles to the user.

[ User Maintenance { ) 5/31/2010

Prtogn [l | W4 bW
First Marme | John | Last Mame |Smith | User Code | WS
Password Canfirm Pagsword Customization Group Expires :
1. Maintenance ] 2 Preferences ]
Compary Role Start Date Expiration Date ?33
ABC [ABC Distribution and Service Con AP Clerk - :?d -

2 -

[ User sccount Locked [ Accept I Cancel I Delete ]

8 Enter a Start Date and Expiration Date for each role to start and end for
the selected company, if required.

é NOTE 9 Click the Preferences tab and select user-specific preferences for the user
I you have multiple and click Accept. For more information, see Setting Additional User
roles assigned to a .

user, the role with Preferences for Security on page 114.
the most access

takes precedence.
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Copying a User

You can create a new user from an existing user. You can copy information
including roles and preferences.

To copy a user

1 Use any of the following methods to open the User Maintenance
window:

¢ In the Administrative Tools screen, click User Maintenance.
¢ Select Library Master Main menu > User Maintenance.

2 In the User Maintenance window, enter a new user logon.

[ User Maintenance (ABC) 5/31/2010

bertogn [ | W4 bl
First Mame | Last Mame | ‘ User Code
Password Confirm Password Customization Group Expires j
1 Maintsnance ] 2 Praferences l
Company Role Start Date Espiration Date =
1 g - &

I Accept [ LCancel I Delete m

3 Click Copy.
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4 Inthe Copy User window, at the Copy From field, enter the user you are
copying from.

[ Copy User

Copy From | maj |Ck
User Logon | |

Optiohs
Copy Aoles
Copp Prieferences

Proceed LCancel E]

5 Select whether you are copying all user information including roles and
preferences, and then click Proceed.
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Setting Additional User Preferences for Security

& Nore User preferences are preferences that apply to each user. You can set up
You can access se . T .

\ additional security measures for individual users such as setting a
User Maintenance . : . .
only if you are workstation to automatically log off, and manually locking certain users
logged on as out of the system.

Administrator, or if
you have arole For security purposes, a workstation can automatically log off if it is left
assigned to you that ttended f ified iod of ti This feat that
allows accessto  unattended for a specified period of time. This feature ensures that
User Maintenance. Workstations are not accidently left with the software running, allowing

unauthorized users access to sensitive information.

The Automatic Logoff feature is not activated if the Sage ERP MAS Desktop
is the active window on your workstation. In addition, the Sage ERP MAS
Desktop does not automatically shut down any activity in process, such as
an update or report, that is currently processing, or if the Sage ERP MAS
Desktop is idle within an option's window, such as a data entry or inquiry
window.

Setting a Workstation to Automatically Log Off

To automatically log off a workstation

1 Use any of the following methods to open the User Maintenance
window:

¢ In the Administrative Tools screen, click User Maintenance.
* Select Library Master Main menu > User Maintenance.

2 Select a user at the User Logon field.
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3  Click the Preferences tab and select the Automatic Logoff check box.

[ User Maintenance (4BC) 5/31/2010

ior Lo Y

First Name | John Last Name | Srith User Code | JWwS
Pazsword | 33353434 Canfim Password | $333533% Customization Group || Erpires

1. Maintenance ] 2 Preferences ]

Autamatic Logoff D Automatic Logoff Delay in Minutes
Implied Decimal Point Use Graphic Report Format
Low Speed Cannection O Partial Lookup Default Begins with

Laokup Limit For [nitial Display 1] Prompt for Compary Code |:|

[ENTER] key Like [TAB] Key for Grid Default Repart Preview Zoom 1007 w
Dizplay Reduction Amounts in Red Use Crystal 'wWeb Reports O
Display Foimatted Credit Card O Enable C/5 ODBC Driver O
Print Formatted Credit Card D Spawn Tasks from Application Server I:‘
Enable 'web Services O
[ User sccount Locked [ Accept I Cancel I Delete m

4 At the Automatic Logoff Delay in Minutes field, type the number of
minutes that the system is to remain active before automatically logging
off this workstation. The maximum amount of time that can be specified
is 999 minutes.

5 Click Accept. After you save a user record, the dollar signs ($) in the
Confirm Password field disappear.
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Locking Users Out

Another security feature is the option to lock users out of the system. This
procedure illustrates how to manually lock users out of the system. Users
can also be locked out of the system if a number of incorrect logon attempts
occur, or if the expiration date for all users' roles has expired. This can be
done using the System Configuration task.

To lock users out of the system

1 Use any of the following methods to open the User Maintenance
window:

e In the Administrative Tools screen, click User Maintenance.
® Select Library Master Main menu > User Maintenance.

2 Select a user at the User Logon field.

5 User Maintenance ( ) 513172010

User Logon 44 b #
First Name | John Last Name | Smith User Code |JWS
Password | $383534% Confirm Passward | $335853% Custamization Group E wpires =
1. Maintenance ] 2 Preterences l
Company Rale Start Date E=piration D1ate
1 | ABC [ABC Distribution and Service Con AP Clerk - E‘- -
= 8 v
[] User Account Locked l Accapt [ Cancel l Delete ] @

3 Select the User Account Locked check box and click Accept.
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Setting System Preferences

The software is equipped with a number of features that can effectively
keep unauthorized users from accessing programs and files. In addition to
basic security features, additional measures can be taken to further secure
your data. These additional measures include, requiring a password,
enabling intruder detection, and specifying lockout duration.

Requiring a Password

To further protect your system, you can require all users to have a
password. First decide if you will set up your users with a unified logon, or
a Sage ERP MAS logon. A unified logon allows Sage ERP MAS to
authenticate and use the Windows logon. If you implement a unified logon,
users do not need to reenter a logon and password when accessing the
software. You can, however, require that users enter their password before
accessing the software. A Sage ERP MAS logon is independent of the
Windows logon, and will be required to enter the software.

When you set up a Sage ERP MAS logon, you can enable intruder detection.
Intruder detection locks a user out of the system when a certain number of
logon attempts fail. This prevents unauthorized users from trying
numerous passwords while attempting to access your system.
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To require a unified logon

1 Use any of the following methods to open the System Configuration
window:

¢ In the Administrative Tools screen, click System Configuration.
* Select Library Master Main menu > System Configuration.

2 In the System Configuration window, select the Use Unified Logon
check box to enable a unified logon for each user.

145 System Configuration [ABC) 5/31/2010 Q@@

Registered Customer | Sage

1 Security ] 2 Modules l 3. Registration ] 4 wieb Services l 5 ODBC Driver ]

Unified Logon

Use Unified Logon O

Internal Security

Require all Users to Enter a Pagsword |:|
Length
Days
Attempts
Minutes

ODEC Security

Enable ODBC Security within Role Maintenance D

3 Click Accept.

To require a Sage ERP MAS password

1 Use any of the following methods to open the System Configuration
window:

* In the Administrative Tools screen, click System Configuration.

¢ Select Library Master Main menu > System Configuration.
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2 In the System Configuration window, select the Require all Users to
Enter a Password check box.

[ System Configuration (ABC) 5/31/2010

Registered Customer | Sage Uninstall...

1. Security 2 Modules ] 3. Reqistration ] 4 Web Services ] 5 ODBC Driver ]
Unified Lagon
Use Urified Logan D

Intemal Security

If this check box is selected —F— Fiecuire all Users to Erter & Password O
after user codes are set up
without passwords, when a Lergio
user accesses the PE
software, a dialog box will :t_te":pls
prompt the user to define a e
password, ODBC Security

Enahle DDBC Security within Rale Maintenance O

Ceew | e [B]0)

3 To require passwords that are at least eight characters in length, include
both letters and numbers, and do not include repeating characters,
select the Require all User Passwords to be System Defined Strong
Passwords check box.

4 Toinclude a minimum length on passwords, select the User Defined
Passwords must be of a Minimum Length check box, and type a
minimum number of characters needed for passwords.

5 To require all users to change their password after a number of days,
select the Force Password Change After a Set Number of Days check
box, and type a number of days.

6 To enable intruder detection, select the Lock Out User After a Set
Number of Invalid Logon Attempts check box, and then type the
number of attempts you will allow before a user is locked out of the
system (cannot attempt to log on anymore).
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& 7 To specify an optional lockout duration, select the Unlock User After a
NoTE Set Number of Minutes Elapse from the Last Invalid Logon check box,

If you do not specify . .

alockout duration, a and type the amount of time you want the lockout to be in effect. After

user locked out by the amount of time has passed, the user can attempt to access the
intruder detection system.

can attempt to log

back onto the

system only if the £ System Configuration (ABC) 5/31/2010

User Account
Locked check box is
cleared in the User
Maintenance
window.

Registered Customer | Sage i

1 Secuity ] 2 Modules l 3. Registration ] 4 "Web Services l 5. ODBC Driver ]

Unified Logon

Internal S ecurity

Require all Users to Enter a Pagsword

Require all User Pazswords ta be Systemn Defined Strong Passwords I:‘

User Defined Passwords must be of a kinimum Length [ Lengh

Foice Password Change After a Set Mumber of D ays |:| Days

Lock Out User After 3 Set Mumber of Invalid Logon Attempts Attempts 3

Unlock User &fter a Set Number of Minutes Elapse from the Last Invalid Lagon Minutes 120
ODEC Security

Enahle DDBL Security within Role Maintenance O

8 Click Accept.
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Setting Accounting Date Preferences

The software maintains personal preferences for each workstation. One of
these preferences is to prompt for the accounting date the first time a user
accesses a module for that day, or you can automatically default the
accounting date based on the system date.

Setting a Prompt for the Accounting Date

If a prompt for the accounting date is not set in Company Maintenance, the
module defaults to the accounting date it was last set at on that
workstation, unless the Auto Set Accounting Date from System Date check
box is selected.

To set a prompt for the accounting date

1 Select Library Master Main menu > Company Maintenance.
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2 On the Preferences tab, select the Prompt for Accounting Date check
box. The default date is the system date.

[ Company Maintenance [ABC) 5/31/2010

Company Code 4 4 b ki Activate.. Conwvert...

Company Name |ABE Distribution and Service Corp, ‘

1. Main ] 2 PfEfEfEI"CBS] 3 Servers ] 4 E-mail ] B Fax ]

Change Data Location.
Credit Card Encryption..

Miscellaneous

PFrint User Logon on Reports

Use Work station Default Printer for STAMDARD Report Setting
Use Wrkstation Default Printer for STAMDARD Form Code

Allovs External Access

OOsEO

Fieturn City Mames in All Caps
Data Location | C:%Program Files\Sage Software\ERP Server\MAS5S30NMAS_ABCY
Payrall Data Location | C:Program Files\S age Software\ERP ServersMASI0AMAS_ABCY

Date Settings
Prompt far &ccounting Date
Restrict Accounting Date to Current and One Future Period O

Background Color

Enable Company-Specific Background Color D
Aasvabe (7] [ ][ ]

Wieb Services

Enable Web Services O

[ Accept I LCancel I Delete

3 Click Accept.
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Sefting the Accounting Date from the System Date

The accounting date for all modules can be set from the workstation's

system date for convenience and to ensure that users do not accidentally

use an old accounting date.

To set the accounting date from the system date

1 Select Library Master Main menu > Company Maintenance.

2 On the Preferences tab, select the Auto Set Accounting Date from

System Date check box.

(i Company Maintenance [ABC) 5/31/2010

44 b P

Company Mame | ABC Distribution and Service Corp,

Company Code

Data Location

Date Settings

Auto Set Accounting D ate from Spstem Date

Restrict Accounting Date to Current and One Future Period

Background Colar
Enable Company-Specific Background Color

wieb Services

Enable Web Services

O

O

O

1. Main ] 2 Preferences ] 3 Servers ] 4. E-mail ] 5 Fax ]

Miscellaneous

Print User Logon on Reports D
Use Workstation Default Printer for STANDARD Report Setting

Use “Workstation Default Printer for STAMDARD Form Code
Allow External Access O

Return City Mames in All Caps D

C:\Program FileshS age Software\ERP ServersMASI0AMAS ABCY
Payroll Data Location | C:\Program FileshS age Software\ERP ServersMASI0AMAS ABCY

RGE Value Sample Text

[ Accept 1 LCancel 1 Delete m

3 Click Accept.
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Restricting the Accounting Date to Current and One Future
Period

When performing certain data entry and register printing functions, the
accounting date is used as the default. When the posting date used for
updates does not fall within the current and one future period for the
module, the summarized totals for the current or future period will not
match the transaction detail reports.

To prevent this problem, users with supervisor rights can restrict the
accounting date to the current and one future period for the Accounts
Payable, Accounts Receivable, Inventory Management, Job Cost, Purchase
Order, and Sales Order modules.
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To restrict the accounting date

1 Select Library Master Main menu > Company Maintenance.

2 On the Preferences tab, select the Restrict Accounting Date to Current
and One Future Period check box.

[ Company Maintenance (ABC) 5/31/2010

M4 bw

Company Name | ABC Dishibution and Service Corp.

Company Code

1. Main ] 2. Preferences | 3 Servers ] 4 E-mail ] B Fax l

Change D ata Location...
Credit Card Encryption....

Miscellaneous

Print User Logon on Reports

Use Warkstation Default Printer for STANDARD Report Setting
Use Warkstation Default Printer for STANDARD Farm Code:

Allow Extemnal Access

OOoFEO

Rieturn City Names in &l Caps
C:\Program FilesvSage Softwareh\ERP Server\MASIONMAS _ABCY
Payroll Data Location | C:\Program Files\Sage Software\ERP Server\MA5S30NMAS_ABCA

Data Location

Diate Settings

Prompt for Accounting Date
Restrict Accounting Date to Curent and One Future Period
Background Color

Enable Compary-Specific Background Color |:|

“Web Services

Enable Web Services [l

[ Accept I Cancel I Delete

3 Click Accept.

Installation and System Administrator's Guide 125



Chapter 12 Performing System Startup

Changing Your Administrator Password

Changing your administrator password on a frequent basis is a good idea
to protect your system from unauthorized users.

To change your administrator password

1 In the Administrative Tools screen, click Administrator Password.

Eﬁ Administrator, Security Passwond

Type a password for the Administrator logon below.  The Administrator
4 b logon only has access to certain Library Master programs and cannot be
uzed to n other modules.

Pagsword

Confirn Pagsword

(o ] e [0

2 Inthe Administrator Security Password window, enter a new password
and then confirm the password. Click OK.
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Setting Up Security on SageCRM

This section describes basic security concepts for SageCRM, including how
to log on after installing, passwords, and the types of security that can be
set up. For more information about SageCRM security, refer to your
SageCRM System Administrator Guide.

Logging On as the Administrator

After installing SageCRM, you can log on as the system administrator with
a user name of admin and no password. You should also change the
password to prevent unauthorized administrative access.

User Authentication / Password Setup

A user requires a user name logon ID to access the system. You can also set
the minimum length and strength of passwords. A user's password is
encrypted both within the system and in the database for maximum
security. The System Administrator can change, but not view, a user's
existing password.

A password can also be set to expire within a specified number of days.
When the password is changed, the expiration date is adjusted accordingly.

Security Profiles and Territories

The system administrator can manage security access rights across the
organization by setting up security profiles and territories. A profile is a
way of grouping users together when defining access rights (for example,
View, Update, Insert, and Delete).

In addition to basic access rights profiles, you can further divide users
rights by territory. For example, you may want users in the West Coast
territory to view all Opportunities within the East Coast territory, but not to
be able to update them.
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Field Security

The system administrator can set up field security for the whole SageCRM
system, for individuals, teams, and for security profiles.

For example, it is possible to make a field invisible to some users, allow
others to view the contents of the field but not to change it, and allow others
to both view and change it. In addition, it is possible to require a field entry
before the user can submit the form. For more information on field security,
refer to your SageCRM System Administrator Guide.

Company Team Restrictions

Rights to view the following tabs can be restricted to individual users
depending on company team membership. If a user has not been assigned
to work on an account on the Company Team tab, that user cannot view or
update information in the following tabs:

Quick Look

Dashboard

Marketing (if available)
Notes
Communications
Opportunities

Cases

Company Team
Documents

The tabs are displayed with "no entry" symbols. If the user selects one of the
restricted tabs, a message dialog box is displayed informing the user that
this information is available only to members of the appropriate team.

If the user searches for a related entity, such as an Opportunity, and they are
not on the Company Team of the associated company, when they click the
hyperlink of the entity in the list, a security message dialog box is
displayed.
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Restricting Updates

The Delete and Edit buttons are available on the Company summary page
only if the user is on the Company team.

In addition, rights to update the following tabs can be restricted for
individual users depending on Company Team membership. This means
that if you have not been assigned to work on an account using the
Company Team tab, you can view, but not update any of the following
information related to that account:

® Quick Look

¢ Notes

e Communications
e Leads

¢ Opportunities

e (Cases

¢ Documents

Server Security
There are many ways to secure the system from unauthorized access:

* Use NT Challenge/Response to allow access to clients with a valid
domain login.

e Use SSL Encryption to secure your data sessions with client users.

¢ Use a firewall to restrict unauthorized access from outside of your
network and allow only authorized users through.

You can use all three or a combination of the above methods to secure
connections to the system.
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Database Security

Users do not have direct access to the SQL database for the SageCRM
server. The eWare DLL accesses the database by using a predefined logon.
When a user requests data, the eWare DLL connects to the database using
Microsoft Data Access Components (MDAC) and retrieves the required
data.

For more security the eWare DLL can be configured to access SQL using a
login with limited access, or access with the appropriate rights to add,
change and delete data from every table in the database.

For information on changing the SQL logon password, refer to your
SageCRM System Administrator Guide.

Firewalls

To allow users to access the system remotely, the best way to protect your
network from the Internet is to install a firewall. This will ensure that only
authorized traffic accesses your SageCRM database and protects your
server from unauthorized users. You can configure rules to allow only
certain traffic through. By doing this you can ensure that your server is
protected from Internet attacks. You can also install a firewall in all of your
remote sites and set up Virtual Private Networks (VPNs) to increase the
security of data being sent. Mobile users can be set up as mobile firewall
users so they can access the VPN to transmit and receive data securely.

SSL (Secure Sockets Layer)

Without using a firewall, IIS can use different methods to secure
transmitted and received data. One of these methods is by using an SSL
server certificate. This ensures that data that has been transmitted and
received between the server and the user is encrypted. There are two
versions of SSL encryption: 40-bit and 128-bit. It is currently possible to
crack the 40-bit encryption, but not 128-bit. SSL cannot protect your server
from unauthorized access, only encrypt sessions between the server and a
user.
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An SSL certificate can be imported into IIS to create a secure connection
between SageCRM and its users. When a client logs onto SageCRM, the SSL
certificate is downloaded and the data sent to and from the client is
encrypted. Using this method, anybody can log on and download the SSL
certificate. To be more secure, IIS can be configured to only allow clients
with a SSL certificate installed on their machine and deny anybody without
the appropriate certificate. IIS can also use Windows NT
Challenge/Response, which requests a user to log on using a valid user
name and password for that domain before allowing them access to data.

Application Security

All users must be assigned a valid user name and password by the system
administrator. Each user can be assigned different levels of access security
depending on their job role (for example, IT, Accounts). To increase security,
all users should be advised to use an alphanumeric password of no fewer
than six characters. When IIS uses SSL encryption, SageCRM is aware of
this and when the client attaches any documents to a form in SageCRM, it
sends it through the encrypted session.

Installation and System Administrator's Guide 131



Chapter 12 Performing System Startup

132 Installation and System Administrator's Guide



Chapfter

System Administrator Tasks

This chapter provides procedures for maintaining certain tasks that
are performed by a system administrator.

Determining Who is Accessing the System/Modules

Use Master Console to display all currently logged on users. The
Master Console includes data on each workstation, the module and
task being accessed, and the accounting date for each user.

To determine who is accessing the system/modules

1 Use either of the following methods to open the Master Console
window:

® Select Library Master Main menu > Master Console.
¢ Select File menu > Master Console.
¢ On the Standard toolbar, click the Master Console button.

2 In the Master Console window, determine the module and task
being accessed by viewing the Module column and the Program
column.

(i Master, Console (ABC) 5/31/2010

User Lagon |\wsmlth Active Users

Station Name | CAI500282

Station User Company Module  Program bect Date | HwWND | FID X
[ H jwsmith AEC S5 Launcher 11/7/2009 1901346 4464
* CalsO0zez jwsmith ABC 5Y5 Master Console /742008 2088372 5380

< il | >
Broadcast. IEhutdnwnAll[ Refresh ] m
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Creating Public Tasks

To access tasks quickly, you can organize them into groups in public task
folders that all users can access. In addition to tasks, you can also add
desktop shortcuts and external programs, such as Microsoft Word or Excel,
into a public task folder so that users can select and launch one of these
programs without leaving the software.

Vi Even though public task folders are accessible to all users, individual menu
NOTE tasks within a task folder are still subject to the standard menu security
;oslf:?r:t; ':(;lelm system (if one has been set up). All company, module, menu, and task
assigned toyour  Testrictions assigned to users override all task folder assignments.

user code must
have the Allow
public tasks for
editing security

eventtunedon. 1 On the Sage ERP MAS Desktop, click the My Tasks tab. Right-click the
My Task area and select New > Public Folder.

To create a public task folder and public tasks

2 Type a name for the public task folder and press ENTER.
3 Right-click the folder and select New > Task.

4 In the Browse dialog box, select the module, the menu, and then the
menu task to add to the folder and click Open. The task is added to the
public tasks folder.

Modules | My Tasks

= (=1 BETR

{=2] Report Manager

5 To add more public tasks to this folder, repeat steps 3 and 4, as
necessary.

6 To add an external program to the public tasks folder, right-click the
public task folder and select New > Program.
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7 In the Browse dialog box, click the Folder button and select the external
program, then click Open. The external program is added to the public
task folder.

Modules | My Tasks
-sEm
[E5] Report Manager
&l Calculator

8 To add more external programs to this folder, repeat steps 6 and 7, as

necessary.
4 NOTE 9 You must exit the software and log back on for the new public folder to
All users must exit be accessible. You can access the public task folder from the My Tasks
the software and log
back on before they menu on the Modules Menu toolbar, or the My Tasks tab.

can see the new
public task folder.  You can also delete existing public task folders, and modify existing tasks or

program titles. You can create an unlimited number of public task folders,
and each folder can contain any number of tasks and programs.
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Modifying Company Preferences

136

For each company, you can set a preference to print a user logon on all
reports, allow the company to be accessed externally, and change the

location of the Payroll folder.

To modify company preferences

1 Use any of the following methods to open the Company Maintenance

window:

¢ In the Administrative Tools screen, click Company Maintenance.
e Select Library Master Main menu > Company Maintenance.

2 In the Company Maintenance window, click the Preferences tab.

[ Company Maintenance [ABC) 5/31/2010

Company Code 4 4 b ki Actiy
Company Mame | ABC Distribution and Service Corp.

1. Main ] 2 Preferences | 3 Servers ] 4 E-mail ] 5. Fax ]
Miscellaneous

PFrint User Logon on Reports

Use Work station Default Printer for STAMDARD Report Setting
Use Wrkstation Default Printer for STAMDARD Form Code

Allovs External Access

OOsEO

Fieturn City Mames in All Caps
Data Location C:%Program Files\Sage Software\ERP Server\MAS5S30NMAS_ABCY
Paprall Data Location | C:\Program Files\S age Software\ERP ServersMAS30AMAS_ABCY

Date Settings
Prompt far &ccounting Date
Restrict Accounting Date to Current and One Future Period O

Background Color

Enable Company-Specific Background Color D
RGB Value Sample Text
Wieb Services

Enable Web Services O

Change Data Location.
Credit Card Encryption..

[ Accept I LCancel I Delete

3 To display the user logon of the user generating a report or listing on all
reports, select the Print User Logon on Reports check box.
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4 To default to the workstation's default printer when printing reports
(such as the General Ledger Detail Report) with the STANDARD report
setting, select the Use Workstation Default Printer for STANDARD
Report Setting check box. Clear this check box to save a specific printer
as the default for the STANDARD report setting in the report windows.

5 To default to the workstation's default printer when printing forms
(such as sales orders) with the STANDARD form code, select the Use
Workstation Default Printer for STANDARD Form Code check box.
Clear this check box to save a specific printer as the default for the
STANDARD form code in the form windows.

6 If SageCRM is installed, to allow communication between Sage
ERP MAS and the SageCRM server, select the Allow External Access
check box. This check box must be selected for the company to be
accessed externally through the company's objects, such as VBScript,
JavaScript, and other programs that are not based on Sage ERP MAS.

7 To change the location of the Payroll folder for security reasons, click
Change Data Location, and type the path of the new location. The data
location is company-specific and not module-specific. The path must be
appended with MAS_XXX, where XXX represents the company code.

8 Click Accept.

Uninstalling Modules

You can remove menu records and programs from the software for a
specific module. Prior to removing modules, this utility will check to ensure
there are no data files for that module. If data files exist, they can be deleted
using the Remove feature in Company Maintenance.

The Custom Office module cannot be removed using Uninstall Modules.

Removing this module will impact access to customized forms and
user-defined fields (UDFs).
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Removing the Visual Integrator (VI) module will remove the module from
the Modules menu; however, the VI folder and two associated files, VIOPER
and VIOXRF, will remain in the file structure. The VIOXREF file contains the
definitions for the default VI perform logic and is a cross-referenced file

that provides shared UDF access between Visual Integrator and Custom
Office.

To uninstall a module

1 Use either of the following methods to open the System Configuration
window:

* In the Administrative Tools screen, click System Configuration.
e Select Library Master Setup menu > System Configuration.
2 In the System Configuration window, click Uninstall.

3 In the Uninstall Modules window, select the module to uninstall and

click Delete.
[ Uninstall Modules g@@

Code Module
AP Accounts Payable
AR Accounts Receivable
B/M Bill of Materials
B/R Bank Reconciliation
c/u Customer Relationship Management
F/L Fined Assats
1M Inventory b anagement
PO Purchase Order
R Retun Merchandise Autharization
R/M Report Master
5/0 Sales Order
VA Wisual Intearator
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Advanced Features and @gg;;g;gt;f:ggggs
Troubleshoofting

Sage ERP MAS 200 SQL
This chapter explains some of the advanced features of Sage ERP
MAS 200 and 200 SQL, including Remote Access using Windows
Remote Access Server (RAS), push-down installation through
Microsoft's Systems Management Server (SMS), and some basic
troubleshooting techniques. Detailed technical information required
by some IT professionals is also provided; some of the content in this
chapter may not be applicable to every Sage ERP MAS user.

Remote Access

Sage ERP MAS 200 and 200 SQL are ideally suited for remote access
and wide-area networks (WANSs) by virtue of the product
architecture. Communication across the remote connection is limited
to data displayed on the window and user interface commands from
the server. The local workstation handles the actual user interface and
leaves the processing to the server.

Remote Access Server (RAS)

é NoTE Performance through RAS is slower than the performance of a
;ﬁ:’;:ﬁmﬂ; the computer attached directly to the network because the transfer rate is
records displayedin limited by the Internet connection speed. The minimum workstation
alookup by setting  requirements are the same for a remote workstation as they are for a
:hi_ LI";F“F: LITIt|;or local workstation. For operating system requirements, see the

i;‘ 'L'?Lras,p,\f ;lstfr Suppqrted Platform Matrix in thg Support area of the Sage Online
User Maintenance. WWeb site (www.sagesoftwareonline.com).

The server must be configured with RAS provided by Microsoft on
the appropriate Windows Server DVD. For more information on
installing and configuring RAS on your server system, consult a
Microsoft Windows Server engineer or consultant. The minimum
bandwidth is 33.6 Kbps per user.
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After RAS is configured, remote users should be able to dial into the
network and log on. Before attempting to start Sage ERP MAS, perform the
following tasks:

* Verify that you can access Windows Explorer and see all appropriate
network resources.

e Verify that there are no firewalls between the remote dial-in and the
server.

* Verify that the IP addresses are unique.

* Verify that you can ping to the server to which Sage ERP MAS is
installed.

If these tasks are successful, Sage ERP MAS will start. Run the workstation
installation wizard from the server. The installation may take several
minutes, depending on the speed of the network and the modem
connecting the workstation to the server.

Sage ERP MAS does not require a logical drive connection; however, if you
intend to use Crystal Reports or other third-party software that accesses
Sage ERP MAS data files, these programs will require a drive mapping.
When accessing a system remotely, if possible, install the applications on
the local hard drive rather than accessing them from the server. This
minimizes the amount of data transferred across the phone line and
significantly improves performance.
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Verify that routers
and other network
services do not
re-map IP
addresses for the
server or
workstation when
packets are
transferred through
the WAN.

é NOTE

Selecting the Low
Speed Connection
check box is
recommended in
environments with
low bandwidth.

REMOTE ACCESS

Wide Area Networks (WAN)

Sage ERP MAS runs on any TCP/IP-based WAN and has been tested using
ISDN, Frame Relays, and T1 connections. The configuration and setup of
Sage ERP MAS on a WAN are the same as those for remote access, and the
same tests should be performed to make sure the remote workstation can
access all network resources (including the ability to ping to the Sage ERP
MAS server). Individual requirements vary from site to site, based on the
amount of data being transferred and the number of users on the system.
Sage cannot support the various hardware configurations possible in
TCP/IP WAN:S. To set up and configure TCP/IP WANs using Windows
servers (including routers, gateways, and DNS servers), consult with a
Windows server WAN specialist or a Sage business partner qualified to
support WAN configurations.

Performance Over RAS/WAN

When running Sage ERP MAS over a WAN or Remote Access Server (RAS),
you will experience slower system performance, specifically with screen
displays. Slower system performance is caused by actions that travel from
the remote workstation through the phone lines or dedicated cabling to the
server, which processes the request and sends the response back to the
remote workstation. Clicking action controls (such as buttons) may require
you to click the control more than once before the action begins. To make
sure the command executes, hold the mouse button down until you see the
button change to its depressed mode. When you release the mouse button,
control returns to its normal mode. Additionally, do not click controls
before the screen loads completely.

The Low Speed Connection check box on the User Maintenance Preferences
tab will turn off the screen display while the panel is loading. Otherwise, if
you click controls before they are loaded completely, you may receive some
error conditions if certain controls are not loaded or are not properly
initialized. Similar conditions may also be experienced when running
through Windows with Terminal Services, especially if you are dialing in to
the Windows server.

Installation and System Administrator's Guide 141



Chapter 14 Advanced Features and Troubleshooting

Virtual Private Network (VPN)

If you are implementing VPN, you should consider that software-based
solutions, such as VPN bundled with Windows Server on low speed
connections, may slow performance, because of the security overhead.

Pinging to a Server or Workstation

If you are having problems pinging to a server or workstation, for each
LAN workstation, use the built-in TELNET utility to ping the specific
socket and port the Application Server is listening on. For remote
workstations, you can use ping and TELNET if the server’s router or
firewall does not block Internet Control Message Protocol (ICMP)
commands. If the router or firewall does block ICMP commands, use a port
scanning utility instead.

Configuring the Workstation for the ODBC Driver Service

When configuring a Sage ERM MAS 200 workstation to use the
client/server ODBC driver, if a failure occurs when testing the connection
from the workstation to the client/server ODBC service, use the built-in
TELNET utility or a port scanning utility to verify the workstation can
connect to the server on port 20222.
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Hanging Processes

On occasion, a process may become orphaned from the workstation if the
connection between the workstation and server fails. This is more prevalent
in low bandwidth remote WAN connections where reliability and stability
cannot be guaranteed.

Detecting Existing Processes

When the Sage ERP MAS Desktop is started, Sage ERP MAS checks to see
whether any processes exist for that computer. If there are orphaned
processes or if a Sage ERP MAS Desktop is already in use by this
workstation, a message dialog box appears informing you that another
Desktop has already been started for the computer.

Users in a LAN environment should not encounter these errors unless an
error previously occurred, causing the workstation to lose its connection
with the server, or if another Sage ERP MAS Desktop is in use for this
workstation. There is also the possibility that another computer on the
network has the same name as the machine attempting to connect to the
server.

Ending Processes

A W If the message dialog box stating that a Sage ERP MAS Desktop is already
0 ARNING i use appears when there is no Desktop in use, use Windows Task
se the Windows

Task Managerto ~ Manager to end any orphaned processes.

end processes only

when the tasks for  Use this option only when you are certain that the tasks left on the server

this machine are -~ are, in fact, orphaned and not processing any information. Tasks that are

known to be "dead." . din th iddle of dat i t dat th h

Killing "live" tasks in interrupte .mt e middle of an update can continue to update, even thoug

this mannermay  the connection has been severed. If an update process has started and the

cause data connection is lost, let the task complete and end rather than "kill" the task

corruption orloss. - y;5ine the option mentioned on page 144. Unless a remote connection is
extremely stable (such as a dedicated ISDN line), do not run update or
register programs from a remote workstation. This reduces the chances of
data corruption and allows the files to be updated and closed correctly.
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To end an orphaned process
1 Press CTRL+ALT+DELETE to access the Windows Task Manager.
2 In the Windows Task Manager window, click the Processes tab.

3 Select each instance of Pvxwin32.exe, and click End Process.

Increasing Default Limits Set by Windows Server

Windows servers may limit the number of Sage ERP MAS processes that
can run simultaneously, especially when the Application Server has been
configured to run as a service. This can create an issue when a significant
number of users are using Sage ERP MAS at the same time. Blank, white
screens may appear when any user tries to start a new task. If a user closes
down an existing screen and then tries to open the original task, it then
opens successfully. For more information on this issue, use the Knowledge
Base on the Sage Online Web site at www.sagesoftwareonline.com to search
for the following text: White screen appears if over 75 tasks are open.
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Appendix 7

Sage ERP MAS Security Permissions

The information in this appendix provides the minimum Share and
NT File System (NTFS) permission settings for servers and
workstations to work properly with Sage ERP MAS. This appendix
also provides procedures for setting permissions.

Setting NTFS and Share Permissions

There are two methods mentioned in this appendix for applying
permission settings in an operating system: the Share (share point)
method and the NTFS method. The following procedures describe
how to set permissions using each method.

To set permissions using the Share method

1 In Windows Explorer, right-click the share point folder and select
Properties. The Properties window appears.

N

Click the Sharing tab, and then select Share this folder.
3 Click Permissions. The Permissions window appears.
4 In the Group or user names section, select the group or user.

5 In the Permissions section, select the applicable permission (Full
Control, Change, or Read).

To set permissions using the NTFS method

1 In Windows Explorer, right-click the folder and select Properties.
The Properties window appears.

2 Click the Security tab.
3 In the Group or user names section, select the group or user.

4 In the Permissions section, select the applicable permission (Full
Control, Change, or Read).
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Sage ERP MAS Server Minimum Permission Settings

The following information provides minimum permission settings for the
local user account running on the Sage ERP MAS server and for any
network user account accessing the server from another computer.

Permissions for the Local User Running the Sage ERP MAS
Server

The following table provides the minimum permission settings for the local
user account running the Sage ERP MAS application either as a service or
an application. The user account must be a member of the Administrators
group (or equivalent). Do not use the system account to run the Sage ERP
MAS server application.

Set the share point and NTFS permissions in the table below for the local
user account running on the server to perform the functions and tasks
indicated.

Minimum Minimum
Share NTFS Folder
Permission Permission
Application Change Full Control .\MAS90
Utilities
Business Change Full Control -.\MAS90
Insights
Explorer
Business Change Full Control .\MAS90
Insights
Reporter
Change Data Change Full Control .\MAS90
Location (for the
destination
location)
Custom Office Change Full Control -\MAS90
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Minimum Minimum

Share NTFS

Permission Permission
Office Template Change Full Control .\MAS90
Manager
Modifying Change Full Control .\MAS90
Forms and
Reports from
within
Modules
Library Master Change Full Control .\MAS90
Utilities (for the Sage

MAS 90

share point)

Printing Tasks Change Full Control .\MAS90

Report Change Full Control -.\MAS90
Manager

Updates for Change Full Control .\MAS90
Pre-Version 4.0
Modules

Updates for Change Full Control .\MAS90
Version 4.0
Modules

When updating user-defined fields (UDFs), if alternate directories exist, the
account running on the Sage ERP MAS server must have Change
permissions set to all share point folders where company data exists to be
able to update records.
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Permissions for Other Users accessing the Sage ERP MAS
Server

The following information provides the minimum permission settings for
user accounts performing Sage ERP MAS tasks on the Sage ERP MAS
server from another computer.

Minimum Minimum
Share NTFS File or Folder
Setting Setting
ACH Change Write - AMASxxx\ APxxx
Electronic where xxx represents the
Payments company code
Folder (Default folder can be
changed in Accounts Payable
Options)
Application | No No
Utilities Permissions | Permissions
Required Required
Business Change Write ..\MAS90\BIExplorer\views
Insights
Explorer
Business Change Write Files:
Insights .\MAS90\Providex. DDF
Reporter .\MAS90\PVXVIEW
.AMAS90\PVXVIEW.GPD
.AMAS90\PVXVIEW.ITM
.AMAS90\PVXVIEW.SRC
AMAS90\PVXVIEW.VUE
Folders:
.AMAS90\HOME\LIB
.\MAS90\MAS_SYSTEM
.AMAS90\Reports\BIReporter
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Minimum Minimum
Share NTFS File or Folder
Setting Setting
Change No No
Data Permissions | Permissions
Location Required Required
Custom No No
Office Permissions | Permissions
Required Required
Office Change No . \MAS90\OfficeTemplates
Template Permissions
Manager Required
Modifying | Change Write AMAS90\MAS_XXX\Reports
Forms and - \MAS90\Reports \###-###
Reports - \MASI90\###-XXX
from within .\MAS90\MAS_System\Reports
Modules
(Where XXX is the company
code)
Federaland | Change Write .AMAS90\MAS_XXX
State \APXXX\eFilingReporting
eFiling and
Reporting . AMAS90\MAS_XXX
\PRXXX\eFilingReporting
(where XXX is the company
code)
Library No No
Master Permissions | Permissions
Utilities Required Required
Paperless Change Write Defined in Paperless Office
Office PDF maintenance tasks
Folder
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é NOTE

For printing tasks, a
Read, Change, or
Full permission is
required to print to
local and network
printers. If no share
permission is
defined, printing is
restricted to
deferred reports.
Access to the
Deferred Printing
task is based on
security settings in
Role Maintenance.
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Minimum Minimum

Share NTFS File or Folder

Setting Setting
Payroll Change Write - AMASxxx\PRxxx
Direct where xxx represents the
Deposit company code
(ACH) File (Default folder can be
Folder changed in Payroll Options)
Printing None/ No
Tasks Read/ Permissions

Change/ Required

Full
Report Change Write AMAS90\MAS_XXX\Reports
Manager - \MAS90\Reports \###-###
(for AMAS9O\###-XXX
modifying .\MAS90\MAS_System\Reports
forms)
Updatesfor | No No
Pre-Version | Permissions | Permissions
4.0 Required Required
Modules
Updatesfor | No No
Version 4.0 | Permissions | Permissions
Modules Required Required




SAGE ERP MAS WORKSTATION PERMISSION SETTINGS

Sage ERP MAS Workstation Permission Settings

The following information provides minimum permission settings that
must be set for Sage ERP MAS workstations.

Installation Security for Workstations

Administrator rights must be set at the local workstation to install the
workstation software and to run the Migrate Level 3 Data wizard and the
Parallel Migration Wizard.

Report Security for Sage ERP MAS 200 Workstations

For Sage ERP MAS 200, reports are cached in the following client
workstation hidden folder:

C:\Documents and Settings\ All Users\ Application Data\Sage
Software\Cache\MAS 200

The permission setting for this folder is set by the operating system, and
should not be changed.

NTFS Permissions for Sage ERP MAS 200 and 200 SQL
Workstations

The following NTFS permission settings must be set at the Sage ERP
MAS 200 and 200 SQL workstations.

Minimum NTFS Setting Folder

Modify ..\Mas90\Launcher
Write .\Mas90\Home
Write .\Mas90\Soa
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Appendix

TCP/IP Protocol

AWARNlNG Sage ERP MAS uses the TCP/IP protocol for all communications
between the workstation and server. TCP/IP must be properly

Do not make

changes to the configured on both the Windows server and all workstations.
TCP/IP

configuration Although this section discusses configuration settings and options
without consulting ilable i fi . TCP/IP k. iti ide f

your system available in configuring a /1P network, it is not a guide for
administrator. installing TCP/IP on your server or workstation. Contact your

Windows systems consultant for specific information regarding the
installation and configuration of TCP/IP on your network.

Basic Configuration

There are no specific requirements for your Sage ERP MAS system
with regard to the configuration of TCP/IP. To determine if a
workstation is communicating with a server or vice versa, ping the
server or workstation.

To ping a server or workstation
ZTXWARNING

If an Internet

C Select Windows Start menu > All Programs > Accessories >
connection is used

in your Sage ERP Command Prompt.

MAS infrastructure,

make sure 2 In the Command Prompt window, type PING MACHINE_NAME,
adequate where MACHINE_NAME is the name of the server or

precautions are
taken to secure the
data traveling
through those 3 If you are successful in communicating with another machine, a

connections. response similar to the output below will appear.

workstation with which you are attempting to communicate.

C:\WINDOWS>PING ERPSERVER

Pinging ERPSERVER [128.0.153.253] with 32 bytes of data:
Reply from 128.0.153.253: bytes=32 time=1lms TTL=32
Reply from 128.0.153.253: bytes=32 time=1ms TTL=32
Reply from 128.0.153.253: bytes=32 time=1lms TTL=32
Reply from 128.0.153.253: bytes=32 time=1ms TTL=32

C: \WINDOWS>
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If you do not get a response and receive messages such as "unknown host
MACHINE_NAME" or "timed_out," then the computer with which you are
attempting to communicate is not receiving or acknowledging information
from the workstation. This indicates that either TCP/IP is not configured
correctly on the server or workstation, or the server is unreachable.

If the workstation cannot find a server by its name, it is likely that a name
resolution mechanism is not in place. If this is the case, go to the server to
find its IP address or contact your system administrator. You will receive a
Bad IP address message dialog box if your name resolution is not working.

If you receive an error message when running the Ping program, it is
possible that the workstation itself is not configured properly for TCP/IP.
Contact your system administrator or a Windows system consultant for
assistance in configuring TCP/IP.

Testing the Configuration for Sage ERP MAS 200 and 200 SQL

After installing Sage ERP MAS 200 or 200 SQL, test the TCP/IP
configuration.

To test the configuration

& Noe 1 At the server, use the built-in NETSTAT utility or equivalent software to
If you encounter verify that the Application Server is running on its configured port. The
problems pinging to R

the server or default port is 10000.

workstation, see

Pinging to a Server 2 From each workstation, ping the Application Server on its configured

or Workstation on port. The TCP/IP built-in ping.exe utility does not provide a way for

Page 142 pinging a specific port. The network administrator should use port
scanning software or equivalent to ping the specific port the
Application Server is listening on.

154 Installation and System Administrator's Guide



Appendix

Running in a Terminal Services O
or Citrix Environment

Sage ERP MAS 200 SQL

The Sage ERP MAS server supports running through a Windows
Server with Terminal Services enabled.

The Sage ERP MAS server application should be installed on a server
within the LAN that is not running Terminal Services/Citrix. Remote
users connect up to a Windows server running Terminal Services.
From there, they run the workstation component and connect to the
Sage ERP MAS server. This limits the amount of processing and
resources required by the Terminal Server computer. Separating out
the workstation and server components allows users coming through
Terminal Services to take advantage of the client-server architecture
of Sage ERP MAS.

Installing the Sage ERP MAS Server

Install Sage ERP MAS as you would any other installation. This
server should not have Terminal Services running on it. Because the
Sage ERP MAS server is doing all the processing for each of the
clients attaching to the server, having the additional burden of
running Terminal Services will slow down the server significantly.
The Sage ERP MAS Server can be a Windows server that meets the
minimum system requirements for Sage ERP MAS.

Users can connect to the Sage ERP MAS server from anywhere on the
network; they do not have to come in through the Terminal Server.
This flexibility allows some users who are running through a
corporate intranet to connect directly to Sage ERP MAS while remote
users can run Sage ERP MAS through the Terminal Server.

Installing on the Workstation

From a Terminal Services/Citrix session, run the workstation
installation wizard logged on as an administrator. Do not run the
workstation installation wizard directly at the Terminal
Services/Citrix Server.
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Insert the Sage ERP MAS product DVD into the Terminal Services Server
DVD drive. If the Autorun screen does not appear, select Windows Start
menu > Run and type D:\ Autorun.exe, where D:\ is the DVD drive.

You can also run Workstation Setup from the Sage ERP MAS server’s share
point by browsing to the MAS90\Wksetup folder and double-clicking the
WKkSetup.exe file.

Because multiple users will use the Sage ERP MAS client, a multi-user
activation key is required. To obtain this key, you must first activate the
server before running Workstation Setup. This causes a multi-user
activation key to be copied to the Sage ERP MAS client folder on the
Terminal Services Server.

To install the workstation, see Workstation Setup on page 21 for Sage ERP
MAS 200 or page 35 for Sage ERP MAS 200 SQL.

Terminal Services Considerations

Sage ERP MAS will retrieve the workstation name of the client that is
coming into the Terminal Server environment and will use that
workstation's name for tracking sessions. This allows for a single
installation of the workstation that all users can access; however, verify that
all user's machines that are coming in through the Terminal Server have
unique workstation names.

Because multiple users will use the Sage ERP MAS client, a multi-user
activation key is required. To obtain this key, you must first activate the
server. After the server is activated, running the workstation installation
wizard through a Terminal Server desktop session (not directly at the
server) will copy the ACTIVATE.PVX file in the Sage ERP MAS server's
MAS90\Home\Lib\Keys folder to the MAS90\Home\Lib\Keys folder of
the Sage ERP MAS client on the Terminal Server.

Sage ERP MAS can be used under the Terminal Services; however, users
must be granted permissions to the MAS90 folder where the client-side
application software is installed, if it is installed on an NT File System
(NTES). For information on NTFS permissions requirements, see NTFS
Permissions for Sage ERP MAS 200 and 200 SQL Workstations on page 151.
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For more information on Terminal Server/Citrix considerations, refer to the
Supported Platform Matrix on the Sage Online Web site at:
www.sagesoftwareonline.com
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Appendix

Sage Configured Installation @2'25;23?3:5%3?&
for SQL Server

The Microsoft SQL Server Runtime Edition 2008 installation DVD
purchased through Sage has a Sage Configured Option for installing
SQL Server. If you select this option, parameter settings are defined
as shown in the following table.

Parameter Setting Description

ACTION INSTALL Specifies a setup work flow,
such as Install, Uninstall, or
Upgrade. This is a required
parameter.

FEATURES SQL, IS, TOOLS Specifies which features to

install, uninstall, or
upgrade. The list of
top-level features includes
SQL, AS, RS, IS, and Tools.
The SQL feature installs the
database engine,
replication, and full-text.
The IS feature installs
Integration Services, which
includes the SQL Server
Import and Export Wizard,
Log Providers and Logging,
XML Source, SSIS
Run-Time, Basic Data
Profiling Tools, and SSIS
Package Designer and
Service. The Tools feature
installs Management Tools,
Books Online, Business
Intelligence Development
Studio, and other shared
components.
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Parameter Setting Description

INSTANCENAME MSSQLSERVER Specifies a default or named
instance. MSSQLSERVER is
the default instance for
non-Express editions, and
SQL Express is the default
for Express editions. This
parameter is required when
installing the SQL Server
Database Engine (SQL),
Analysis Services (AS), or
Reporting Services (RS).

SECURITYMODE SQL SQL is used for
mixed-mode authentication.

SQLSVCACCOUNT SYSTEM Specifies the account for the
SQL Server service:
domain\user or system
account

ISSVCAccount SYSTEM Can be either domain user
name or a system account.

SQLSYSADMINACC ADMINISTRATOR Specifies which Windows

OUNTS account(s) to provision as
SQL Server system
administrators.

AGTSVCACCOUNT SYSTEM Can be either domain user

name or a system account.
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